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Lab-Volt License Agreement 
 
By using the software in this package, you are agreeing to 
become bound by the terms of this License Agreement, 
Limited Warranty, and Disclaimer. 
 
This License Agreement constitutes the complete 
agreement between you and Lab-Volt. If you do not agree 
to the terms of this agreement, do not use the software. 
Promptly return the Tech-World Resources on 
Multimedia (CD-ROM) compact discs and all other 
materials that are part of Lab-Volt's MultiMedia Tech-
World product within ten days to Lab-Volt for a full 
refund or credit. 
 
1. License Grant. In consideration of payment of the license 
fee, which is part of the price you paid for this Lab-Volt 
product, Lab-Volt, as Licensor, grants to you, the Licensee, a 
nonexclusive, nontransferable license to use this copy of the 
CD-ROM software with the corresponding Tech-World 
CELL. Lab-Volt reserves all rights not expressly granted to 
the Licensee. 
 
2. Ownership.  As the Licensee, you own the physical media 
on which the CD-ROM is originally or subsequently recorded 
or fixed, but Lab-Volt retains title to and ownership of the 
software programs recorded on the original compact disc and 
any subsequent copies of the CD-ROM, regardless of the 
form or media in or on which the original and other copies 
may exist. This license is not a sale of the original software 
program of Lab-Volt's CD-ROM or any portion or copy of it. 
 
3. Copy Restrictions. The CD-ROM software and the 
accompanying materials are copyrighted and contain 
proprietary information and trade secrets of Lab-Volt. 
Unauthorized copying of the CD-ROM even if modified, 
merged, or included with other software or with written 
materials is expressly forbidden. You may be held legally 
responsible for any infringement of Lab-Volt's intellectual 
property rights that is caused or encouraged by your failure to 
abide by the terms of this agreement. You may make copies 
of the CD-ROM solely for backup purposes provided the 
copyright notice is reproduced in its entirety on the backup 
copy. 
 
4. Permitted Uses. This CD-ROM, Instructor's Guide, and all 
accompanying documentation is licensed to you, the 
Licensee, and may not be transferred to any third party for 
any length of time without the prior written consent of Lab-
Volt. You may not modify, adapt, translate, reverse engineer, 
decompile, disassemble, or create derivative works based on 
the Lab-Volt product without the prior written permission of 
Lab-Volt. Written materials provided to you may not be 
modified, adapted, translated, or used to create derivative 
works without the prior written consent of Lab-Volt. 
 
5. Termination. This agreement is effective until terminated. 
It will terminate automatically without notice from Lab-Volt 
if you fail to comply with any provisions contained herein. 
Upon termination you shall destroy the written materials, 
Lab-Volt's CD-ROM software, and all copies of them, in part 
or in whole, including modified copies, if any. 
 

 
 
6. Registration. Lab-Volt may from time to time update the 
CD-ROM. Updates can be made available to you only if a 
properly signed registration card is filed with Lab-Volt or an 
authorized registration card recipient. 
 
7. Miscellaneous. This agreement is governed by the laws of 
the State of New Jersey. 
 
Limited Warranty and Disclaimer 
 
This CD-ROM software has been designed to assure correct 
operation when used in the manner and within the limits 
described in this Instructor's Guide. As a highly advanced 
software product, it is quite complex; thus, it is possible that if 
it is used in hardware configurations with characteristics other 
than those specified in this Instructor's Guide or in 
environments with nonspecified, unusual, or extensive other 
software products, problems may be encountered by a user. In 
such cases, Lab-Volt will make reasonable efforts to assist the 
user to properly operate the CD-ROM but without 
guaranteeing its proper performance in any hardware or 
software environment other than as described in this 
Instructor's Guide. 
 
This CD-ROM software is warranted to conform to the 
descriptions of its functions and performance as outlined in 
this Instructor's Guide. Upon proper notification and within a 
period of one year from the date of installation and/or 
customer acceptance, Lab-Volt, at its sole and exclusive 
option, will remedy any nonconformity or replace any 
defective compact disc free of charge. Any substantial 
revisions of this product, made for purposes of correcting 
software deficiencies within the warranty period, will be 
made available, also on a licensed basis, to registered owners 
free of charge. Warranty support for this product is limited, in 
all cases, to software errors. Errors caused by hardware 
malfunctions or the use of nonspecified hardware or other 
software are not covered. 
 
LICENSOR MAKES NO OTHER WARRANTIES OF ANY KIND 
CONCERNING THIS PRODUCT, INCLUDING WARRANTIES 
OR MERCHANTABILITY OR OF FITNESS FOR A 
PARTICULAR PURPOSE. LICENSOR DISCLAIMS ALL 
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LICENSOR FOR DAMAGES, INCLUDING BUT NOT LIMITED 
TO SPECIAL OR CONSEQUENTIAL DAMAGES ARISING OUT 
OF OR IN CONNECTION WITH THE USE OF THE SOFTWARE 
PRODUCT LICENSED UNDER THIS AGREEMENT. 
 
Questions concerning this agreement and warranty and all 
requests for product repairs should be directed to the Lab-Volt 
field representative in your area. 
 
LAB-VOLT SYSTEMS, INC. 
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Farmingdale, NJ  07727 
Attention: Program Development 
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Introduction 
 

Look upon this CELL Guide as a fixture at this station because it is to remain here. 
It is designed to provide what you need to operate the Automation and Material 
Handling CELL. For example, the first section, "Getting Started," starts you in the 
CELL program. 
 
As you get into the Guide, you will see that it offers information not only on how to 
access and run the CELL but also supporting data such as topic skills, overview, 
objectives, equipment required, and terms used. You will find activity objectives too.  
More importantly, when you close the TW presentation to use the DOS Armdroid 
software, it provides the procedures required to perform the tasks in an activity. In 
the Appendices you will find information about help windows, safety, internet 
resources, a bibliography, and a Consumable Parts List Order Form. 
 
The Table of Contents steers you to whatever area you want to work in. Make good 
use of this guide and remember that it is here for all who work at this station, so 
handle it with care. 
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GETTING STARTED 

Desktop 
After the Tech-Lab System is installed, the TechLab icon appears on the desktop. 
 
1. Click on the TechLab icon on the desktop; a Student Logon window appears. 
 
2. Select your name and click on Logon. 
 
3. Enter your password and click on OK. (If you are creating your password, enter 

four alphanumeric characters. The system will ask you to enter your password 
again for verification. Keep a record of your password.) 

 
4. Continue the previous two steps until all members of your team have logged on, 

then click on Complete. 
 
5. When the Module-CELLs window appears, highlight the appropriate CELL and 

click on the right-arrow (or double-click on the CELL name). 
 
6. A Tech-World window with the name of the CELL and a list of topics for that 

CELL appears. Highlight the topic you want to begin and click on the right-
arrow (or double-click on the topic name). The topic title page appears and you 
are ready to begin. 

Selecting Topics or Exiting the CELL 

1. Clicking on Exit, when in a topic returns you to the CELL topic window. 
 
2. If you wish to select another topic, highlight and click on the right-arrow. 
 
3. If you wish to exit the CELL, click on the left-arrow. The Module-CELL screen 

appears. 
 
4. If you wish to exit Tech-World, click on the Log-Off icon (open door). 
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Navigation 
The navigation bar at the bottom of the screen contains the buttons to navigate 
through the multimedia presentation. 
 
Figure 1 illustrates the right-hand area of the navigation bar while in a topic or 
activity. 

Students navigate through the curriculum by using the mouse to click on the arrow 
buttons or the Reference and Menu buttons. The buttons function as follows: 
 

Menu – Clicking on this button activates one of three menus: Topic, Activity, 
or Reference. The menu activated depends on your current position in the 
curriculum. If viewing a Topic screen, the Topic menu appears. If viewing an 
Activity screen, the Activity menu appears, and if viewing a Reference screen, 
the Reference menu appears. 

 

Right arrow – forward to next screen. 
 
Left arrow – back to previous screen. 
 
Reference – Clicking on the Reference button activates the Reference 
menu. References for that topic are listed on this screen. To access a reference, 
click on the reference title. 

 

When viewing the references, the Reference button is changed to a Return button 
(Figure 2). When you have finished looking at the references, you click on the 
Return button to get back to your previous activity screen. 

Figure 1 

Figure 2 
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The control buttons in the left-hand part of the navigation bar are displayed in 
Figure 3. 

These control buttons provide the following functionality: 
 

Calculator – provides a pop-up calculator window that can be switched 
between standard and scientific. 
 
Help – provides additional information. 
 System help – information common to all CELLs 
 Topic help – extra information for the topic 
 
Bookmark – marks your place within the curriculum. Clicking again returns 
you to the position marked. 
 
Print – prints the screen. 
 
Launch – starts third party software. 
 
Exit – exits the curriculum. 

 
Topic, activity, and reference menus enable you to move to any part of the 
multimedia presentation. 
 
Hot words and hot spots on graphics give you similar ability to get information just 
when it's needed. For a more detailed explanation of the navigation, refer to Topic 1, 
Finding Your Way, in Fundamentals of Manufacturing. 
 
 

Figure 3 
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TOPIC 1 – INTRODUCTION AND REVIEW OF AUTOMATION AND 

MATERIAL HANDLING 

Objective 

When you have completed this topic, you will have reviewed the skills necessary to 
prepare you to operate the entire Armdroid system in an integrated program. You  
will run both the 5100 and 5200 robots, the peripheral feeders and conveyors, and 
the PLC trainer. 

Overview 

Before getting into an overview of Topic 1, a preview of Level 2 is in order. Level 2 
builds and expands on your experiences in Level 1. The entire Level 2 CELL is 
focused on your use of all the equipment in a final topic that integrates both the 
5200 and 5100 robots, the feeders, conveyors, and the PLC trainer. 
 
The earlier topics take you one at a time through the exercises that will later 
become part of the final master activity in Topic 6. You will use the sensors to 
identify and sort materials coming down the conveyor. You will coordinate the two 
robots in a program. You will use the feeders and conveyors. You will see how the 
Armdroid system is truly a flexible manufacturing cell. As you did in Level 1, you 
will also experience supporting references that relate to these activities. 
 
Topic 1 is primarily a review of Level 1, but it also is an introduction to Armdroid 
5100. If you worked with the 5100 in Tech-Design, then view this as a refresher. 
 
Activity 1 introduces the 5100 and provides exercises to familiarize you with its 
operation. Activity 2 follows with a review of the 5200. You will create a program 
similar to ones you did in Level 1. You will review control devices and conveyors 
because of the important part they play in any flexible manufacturing system. 
 
Activity 3 is a refresher on the PLC trainer. You will download a simple program 
and run it to prepare you for later exercises with the PLC. 
 
You have an eventful journey awaiting you. Enjoy all the stops. 
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New Terms and Words 

accuracy – is also known as resolution, which is the standard term for describing 
the smallest increment in which the robot can move. 
armature – the movable part of an electromagnetic device. 
articulating  – jointed; a robot configuration similar to the human arm. 
buffer – any of various devices for reducing shock or damage due to contact; a 
temporary storage unit, especially one that accepts information at one rate and 
delivers it at another. 
continuity – in electrical circuits, a completed pathway that allows electrical 
currents to flow.  In ladder logic, a rung where all conditions have been met so that 
the final logical outcome is a high. 
electromagnetic – a piece of soft iron wrapped in wires that creates a strong 
magnetic force when electricity flows through the wires. 
executive programs – programs supplied by the manufacturer that direct and 
perform the routine operation of the PLC. Examples include the program routines 
that scan input devices and the updating of information to output devices. 
feature-rich – capable of performing several valuable functions. 
flexible manufacturing cells – a group of related machines controlled by the 
same computer and connected through a common material-handling system. They 
are usually set up to manufacture particular parts. 
hard home – a function performed by Armdroid to reset the parameters of its 
motors in starting mode; it goes to the extreme of each movement in its work 
envelope. 
manipulator – a mechanical device for handling objects. 
microprocessor – an integrated circuit that consists of the microcircuitry that 
performs the logic, control, and arithmetic functions of a small computer system. 
microswitch – a small, highly sensitive switch which responds to very little 
contact; used especially in automatic control devices. 
momentary contact – means that when a pushbutton is spring loaded, it returns 
to the first position when pressure is taken off the switch or button. 
motherboard – the main circuit board of a computer system which includes 
interface circuitry for the microprocessor, memory chips, and peripheral devices. 
multitasking – performing multiple applications concurrently. 
optical encoder – consists of a small LED (light-emitting diode) and light detector 
on opposite sides of a spinning disk with many slots. As the light detector senses 
flickering light through the slots, it sends pulses to a controller that interprets these 
pulses as positional information. 
parameters – measurements by which limits of an object are set. 
points - movement or control (such as wait) steps. 
potentiometer – a variable resistor connected with three terminals to provide a 
variable voltage; a device for converting mechanical motion into an electrical-
feedback signal. 
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semiconductor – a material whose conductivity is between that of a good 
conductor of electricity and a good insulator. 
solid-state – made of electronic components that control electron flow through solid 
materials such as crystals. Some examples are the transistors used in the circuit 
board of your computer. 
spool valve – consists of a plunger and a spool or spools that fit tightly against the 
walls of the DCV housing  in the same way that a piston fits in a cylinder. 
ultrasonics – sound waves and vibrations above the frequency at which humans 
can hear. 

Equipment Needed 
Armdroid 5100 with teach pendant 
Armdroid Model 5200 with teach pendant 
Gravity feeder 
Conveyor 
Rotary carousel 
PLC and sensor trainer 
 PLC 
 sensor input box 
 interface converter 
 sensor 6377-A0 (diffuse photoelectric) 
Automated and Material Handling CELL (Computer Enhanced Learning Location) 
Guide 
Block 2x2x1½- in. (4) 
Block 2x2x1-in. slotted block (1) 
Piece of square stock (plain or steel) 
Four-way serial switcher 
RS Logix 500® software 
RS Linx Lite® software 
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Activity 1 – Armdroid 5100 

Objective 

When you have completed this activity, you will have the knowledge and skills to 
operate Armdroid 5100 and create the programs in Level 2. 
 
You will be able to: 
 
• operate Armdroid 5100 using the teach pendant. 
• create a program with the Armdroid 5100. 

Procedures 

 
The 5100 Teach Pendant 
You will familiarize yourself with the parts of Armdroid 5100 by operating it. Follow 
all instructions carefully while using the arm.  It is a fine piece of machinery that 
deserves your respect. 
 
Turn on the power supply.  On the startup screen of the teach pendant, you should 
see D&M Computing, Inc. Armdroid 1001. 
 
Press any key to go to the Main menu. 
 
Select item number 6 Setup. 
 
Press 3 to turn tasking off. 
 
Press the Set Speed key and enter 99. 
 
Press the Teach Menu key. This menu is used to manipulate the robot arm and 
define or record points. 
 
You are now ready to operate Armdroid 5100. Perform the following steps to learn 
what each key does. 
 
1. Press and hold the Base + key to rotate the arm clockwise on its base, moving it 

about 180 degrees. 
2. Press the Base - key to rotate the arm counterclockwise 90 degrees back. 
3. Press the Shdr + key to raise the arm a few degrees. Notice that the arm moves 

at the shoulder joint. 
4. Press the Shdr – key to lower the arm to its former position. 
5. Press the Pitch + key briefly. Don’t let the gripper pitch sharply enough to touch 

the forearm. 
6. Press the Pitch – key to return the gripper to its former position. 
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7. Press the Roll + key to observe how the gripper rotates counterclockwise. 
8. Press the Roll – key to observe how the gripper rotates clockwise on the wrist. 
9. Press the Grip + key and note how the gripper opens. 
 
Press the Grip – key and note how the gripper closes. Don’t close it all the way. 
 
Press the Main Menu key. Next, press 3 (Initial) and then 2 (Move Home) to return 
to the home position. 
 
Before creating the program, you will have to perform the following. 
 
Preliminary Steps 
1. Turn the power switch on. 
2. At the D&M start-up screen press any kP 
3. Press the Set Speed key, then enter "99." 
4. Press the Teach Menu key. Remember, you need to be in the Teach Menu to 

move the robot and record points. 
5. Using movement commands, position the arm at right angles to and about a foot 

above the conveyor as shown. You will make this the Home point. 
6. Press Main Menu, then 3 Initial. This brings up the Initialize Menu screen; 

press 1 Reset Home to set a new Home. 
7. Make sure that there are at least four blocks in the gravity feeder. 
 
The Program 
1. Press Base – to rotate the robot counterclockwise to a point above the blocks. 

Define or record the point by pressing the Data <· > dot key. 

NOTE:  From this point forward, to record a point, press 
the Data <· > key. Remember, if you don't record a point, it 
does not become part of the program. 

2. Press Grip + to open the gripper wide enough (about 3 inches) to hold a block. 
Record the point. 

3. At this point you want to slow the robot down because of the precise movements 
needed to remove the block from the gravity feeder. Using the Arm – , Shdr –, 
and Base +/- keys (if necessary) lower the gripper down around the lowest block 
in the chute.  

4. Use the Pitch +/- keys so that the fingers are at right angles to the block and 
centered as shown. Record the point. Press the Set Speed key, then enter "99." 

5. Close the fingers on the block by pressing the Grip – key and holding it for at 
least 10 seconds after the grippers touch the block.  Since the gripper is spring 
loaded, you must do this to get a firm grip. Record the point. 

6. Then, using the Shdr + key, raise the block about ¾ of an inch. Record this 
point. 
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7. Use the Pitch – key to remove the block from the feeder. The gripper should now 
be 90 degrees to the table top. Record the point. 

8. Using the Arm + and Shdr + keys, raise the block up about 8 inches and record 
the point. 

9. Press Base + to swing the block around clockwise to a point above the conveyor. 
Record the point. 

NOTE: You will not run the conveyor in this program. 

10. Using the Arm – and Shdr – keys, lower the block close (1/8 to ¼ inch) to the 
surface of the conveyor belt. Record the point. 

11. Press Grip + to open the gripper, releasing the block onto the conveyor belt. 
Record the point. 

12. Raise the gripper 8 inches. Record the point. 
13. Press Base – (counterclockwise) to rotate the robot so that the gripper is 

positioned above the lowest block in the chute of the gravity feeder. Record the 
point. 

14. Lower the gripper to within an inch or two above the block. Record the point. 
15. To slow the speed down again, press the Set Speed key, then enter "50." 
16. Lower the gripper's fingers down around the block in the chute. Record the 

point. Press the Set Speed key and set the speed back to 99. 
17. Close the gripper on the block, holding the Grip – key about 10 seconds until the 

robot has a good grip on the block. Record the point. 
18. Then, using the Shdr + key, raise the block about ¾ of an inch. Record this 

point. 
19. Use the Pitch – key to remove the block from the feeder. Hold the key down until 

the gripper is 90 degrees to the table top. Record the point. 
20. Raise the block about 8 inches above the chute. Record the point. 
21. Press Base + to rotate the robot and carry the block to a point above the block on 

the conveyor. Record the point. 
22. After slowing the robot down, lower the block close (1/8 to ¼ inch) to the top of the 

other block, and open the gripper to place it on the other block. Record the point. 
23. Use the Arm + key to raise the gripper at least 4 inches above the blocks. Record 

the point. 
 
You may add to your program by stacking two more blocks. Simply repeat the steps 
just performed, placing the blocks further along the conveyor. 
 
To run your program, do the following: 
 
1. Place the blocks back into the gravity feeder. 
2. Go to the Main menu and press 2 Execute. This brings up the Execute menu.  
3. Press 1 Once to run through your program one time. 

NOTE:  The 2 Forever option runs the program over and 
over until you stop it by pressing the ESC key. 
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Activity 2 – Review of Armdroid 5200 and Peripheral Equipment 

Objective 

When you have completed this activity, you will have the knowledge and skills 
necessary to operate Armdroid, Model 5200, and peripheral equipment and recall 
supporting technology in control devices and conveyors.  
 
You will be able to: 
 
• operate Armdroid 5200, the gravity feeder, the conveyor , and the carousel while 

creating a program. 
• recall types of conveyors and control devices. 

Procedures 

Starting Up Armdroid 
WARNING:  Whenever you work around moving equipment, be sure you are 
wearing nothing that might get caught such as a tie or hanging jewelry. If your hair 
is long, tie it up. 

CAUTION:  Do not remove or insert any cable connections while 
power is on. Doing so will damage the controller. 

1. Make sure that the emergency stop button is in the up position.  
2. Turn on the power to Armdroid at the controller by pressing the rocker power 

switch labeled I for input (on) and O for output (off) at the left rear of the 
controller. 

3. Once the power to Armdroid is activated, the Main menu appears in the teach 
pendant window after several screens are displayed. 

4. Press the 4 key to access the Motion Control menu. 
5. Press 4 (Hard Home) then Enter to perform a hard home. 

NOTE:  Whenever you power up Armdroid, the first thing 
you should do is to perform a hard home to establish the 
robot's default parameters. This is necessary so that the 
starting point, when creating and running programs is 
always the same. 

Press the Teach Menu key to get to the Teach menu. Press 0 to access the Set 
Speed slider. By pressing numbers 2 through 9, you can set the speed by tens (2 for 
20, 9 for 90). You can also use the left and right arrows to decrease or increase your 
speed respectively by ones. However, if you do this, you won't see the slider. 
 
When you are at the Set Speed screen, press Enter to return to the Teach menu. 
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Press T (Base CW) to rotate the robot clockwise at its base. Hold the key down until 
the robot has rotated 90 degrees. 
 
Press 6 (Base CCW) to rotate the robot counterclockwise. Hold the key down until 
the robot has returned 90 degrees. 
 
Press S (Shoulder Down) to lower the upper arm 5 to 10 inches. 
 
Press 5 (Shoulder Up) to raise the upper arm an equal distance. 
 
Press J (Wrist Pitch Up). Note that it raises the gripper (also known as end-of-arm 
tooling or end effector) at the wrist. 
 
Press 3 (Wrist Pitch Down). Note that it lowers the gripper at the wrist. 
 
Press 2 (Wrist Rotate CW) to rotate the gripper clockwise at the wrist. 
 
Press I (Wrist Rotate CCW) to rotate the gripper counterclockwise at the wrist 
 
Press 1 (Gripper Open) to open the gripper fingers. Don’t extend them more than 2 
inches for now. 
 
Press H (Gripper Close) to close the gripper fingers but don’t close them tightly. 
 

Creating a Program with the 5200 System 
Perform the following program to refresh your memory on how to create a program. 
Make sure there are at least two blocks in the gravity feeder. The gravity feeder is 
an example of another kind of conveyor. 
 
1. As usual, perform a hard home. (In the Main menu, press 4 (Motion Control), 

then 4 (Hard Home.) 
2. From the Teach menu, move the robot to a point where the gripper is facing the 

gravity feeder. Record this move or point by pressing the Dot key. 

CAUTION:  All movements must be recorded; the robot 
will not perform an unrecorded movement when you run 
the program. Not recording a point could be dangerous. If 
an omitted point avoided an obstacle, the robot will hit 
that obstacle when you run the program.  

NOTE:  Remember, press the Dot key to record all 
movements. 

Lower the gripper to about 4 inches above the first block in the gravity feeder. 
Record the point.  
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At this point, you want to insert a control or wait point so that Armdroid will wait if 
there is no block in the gravity feeder. Press the G (Digital Input) key to bring up 
the Digital Input menu. 
 
If the gravity feeder wires are plugged into the NC (normally closed) jack, you want 
the robot to wait until the light on the controller goes on (high). Press the number 
corresponding to the color code of the jack (for example, red is 2, 4 is yellow) to 
which the wires are connected on the controller. An H for high should replace the X 
in the Input menu. 
 
Press Enter to return to the Teach menu. 
 
Press the Star (*) key to get to the Save Control window. Give the point a name (P5, 
for example) and press Enter. If the gravity feeder is empty, the robot will wait until 
a block is installed. 

NOTE:  If the wires are plugged into the NO (normally 
open) jack, this setup is reversed; you want the robot to 
wait until the light goes out (L for low). You can check if 
you selected the correct wait point and port by leaving 
blocks out of the gravity feeder and observing how the 
robot responds when you run your program. 

Open the gripper wide enough to grasp the block. Record the point. 
 
You might want to slow the robot down at this point because the next few moves 
must be precise. Press the zero (0) key to bring up the speed slider and press 2 or 3 
to set the speed at 20 or 30. 

NOTE:  Remember, you can lower the speed one point at 
a time by pressing the left arrow. 

To return to the Teach menu, press Enter. 
 
Lower the gripper around the lowest block in the gravity feeder. Record the point. 
 
Close the gripper on the block. Make sure the gripper fingers don't grab the sides of 
the chute on the gravity feeder. Record the point. 
 
Lift the block out of the feeder gently, using the 5 (Shoulder Up) and R (Elbow Up) 
keys. Record the point. 
 
Increase the robot's speed to 90 to shorten the time needed to reach the carousel.  

NOTE:  You can also speed up the robot by pressing the 
right arrow.  
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Move the robot to the carousel by pressing the 8 (Extn2 Forward key). Record the 
point. 
 
At the carousel, lower the block to within an inch of the first empty square on the 
index plate attachment. You will probably have to swivel the gripper (the 2 key for 
CW, the I key for CCW) to fit the block snugly into the square. Record the point.  
 
Slow the robot way down here (about 20) because it is a tight fit getting the block 
into the square. 
 
Ease the block into the square hole and record the point. 
 
Raise the block about a foot and rotate it so that it will be facing the carousel when 
it arrives there. Record the point. 
 
Open the gripper, by pressing 1 (Gripper Open) to release the block. Record the 
point. 
 
Raise the gripper above of the carousel. Record the point. 
 
Raise the gripper by pressing, using 5 (Shoulder Up) and R (Elbow Pitch Up). 
Record the point. 
 
Rotate the carousel 90 degrees clockwise by pressing 8 (Ext2 Forward). Record the 
point. 

NOTE:  Channels 7 and 8 on the controller are 
interchangeable. It is possible that the carousel is 
connected to Channel 7 and therefore would be controlled 
by the 7 Ext1 keys. If so, then the linear slide would be 
operated by the 8 Ext2 keys since it would connected to 
Channel 8. 

Return the robot to the gravity feeder by pressing the Z (Ext1 Backward) key. 
Swivel the robot on its base to face the gravity feeder. Record the point. 
Transfer another block to the carousel. Don't forget to record all your movements. 
Once you have deposited the second block into an empty square, rotate the carousel 
90 degrees CCW by pressing the / (Ext2 Backward) key. This brings the first block 
back to its original position. Record the point. 
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Here is a quick reference for the teach pendant key functions: 
 

KEY  ACTION   KEY  ACTION 
     
 1 GRIPPER OPEN H GRIPPER CLOSE  
 2 WRIST ROTATE CW  I WRIST ROTATE CCW  
 3 WRIST PITCH DOWN  J     WRIST PITCH UP 
 4 ELBOW PITCH DOWN  R ELBOW PITCH UP 
 5 SHOULDER UP  S SHOULDER DOWN 
 6 BASE CCW  T BASE CW 
 7 EXT1 FORWARD  Z EXT1 BACKWARD 
 8 EXT2 FORWARD  / EXT2 BACKWARD 
 
These remaining keys do not move the robot but have other functions: 
 
 F DIGITAL OUTPUT  Y CNC CHANNEL 2 
 G   DIGITAL INPUT  . SAVE ABS POINT 
 P  RELAY POINT  # SAVE REL POINT 
 Q TIME DELAY  * SAVE CONTROL 
 X  CNC CHANNEL 1 
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Activity 3 – Review of the PLC and Sensor Trainer 

Objective 

When you have completed this activity, you will have the knowledge and skills 
necessary to operate the PLC and sensor trainer. 
 
You will be able to: 
 
• recall the place of sensors, PLCs, and ladder logic in manufacturing. 
• load a program into the PLC. 
• verify the operation of the PLC. 

Procedure: Connecting a Computer, a PLC, and a Conveyor 

Insert the female connector on one end of the RS-232 cable into the serial connector 
on the back of the computer.  
 
Connect the other end of the RS-232 cable into the female ribbon connector from the 
SLC500 personal computer interface converter.  
 

NOTE: If the computer is close to the SLC500, then the 
RS-232 cable is not needed. Plug the SLC500 ribbon 
connector directly into the computer serial port. 
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Lift the cover flap in the center of the PLC. Connect the cable connector (it looks 
like a telephone connector) from the SLC500 personal computer interface converter 
to the female connector on the front of the PLC. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Connect the 25-pin connector of the sensor input box into the rear of the PLC. 
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Move the power supply switch to the off (0) position. Insert two separate jumper 
cables with piggy-back connectors into the two holes on the face of the 24-volt power 
supply. Plug the power cord into a 115-volt receptacle. 
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Insert the other end of the jumper cable (the one inserted into the "+" receptacle of 
the power supply) into the receptacle at the upper left (the  "+" receptacle) on the 
PLC. 
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Insert the other end of the jumper cable (the one inserted into the "–" (minus) 
receptacle of the power supply) into the receptacle at the upper left (the "–" 
receptacle) on the PLC. 
 
When both connectors are in place and the power is turned on, the power supply 
will provide 24 volts to the PLC. For now, leave the power switch at the lower left of 
the PLC in the off (0) position. 
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Insert another jumper into the positive (+) terminal of the power supply. Insert the 
other end of that jumper into the positive (red) receptacle of the 6469 voltage level 
converter. 
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Insert another jumper into the negative (–) terminal of the power supply. Insert the 
other end of that jumper into the negative (black) receptacle of the 6469 voltage 
level converter. 
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Insert another jumper into the zero (0) terminal (near the + and – terminals at the 
upper left) of the PLC.  
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Insert the other end of the jumper (the one in the zero receptacle of the PLC) into 
the left, uppermost terminal of the voltage level converter. 
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Insert another jumper into the negative (black) receptacle of the 6469 voltage level 
converter. 
 
Insert the other end into the GND (black) receptacle on the conveyor panel (below 
the Remote Signal receptacle). 
 
 
 
 
 

 

 

 

 

 

 

 

 

GND 
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Insert another jumper into the second upper receptacle of the voltage level 
converter.  
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Insert the other end of that second, upper receptacle jumper into the Remote Signal 
(violet) receptacle of the conveyor panel.  
 
Plug the power cable of the conveyor into a 115-volt receptacle.  
 
You have completed the wiring of the control circuit from the computer to the 
conveyor. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
For the conveyor to work properly, the switches must be set this way: 
 
• Under Motor the switch must be set on Remote. 
• Under Direction, the switch must be set to Remote also. 
• Under Stop On Signal, the switch must be set on Low. 
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Connect sensor number 6377-A0 to channel 0 on the sensor input box. 
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Turn the power switch of the PLC on. To make sure that your circuit is working, 
wave your hand in front of the sensors. An indicator on the right of the PLC should 
light.  
 
 
 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Although lights appear on the front of the PLC, you did not program it to start or 
stop the conveyor. Your next task is to program the PLC so it starts and stops the 
conveyor in response to objects moving in front of the sensors.  
 

Power Switch 
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Directions Window #3-1 

 
1. Pull down the File menu and choose Open. 
 
2. In the Open window, click on the file First.RSS. The file loads into the RSLogix 

windows. 

NOTE:  In this activity, we are using only one sensor 
(6377-A0) in the PLC program. 

3. Place a square piece of stock (supported by a block) in front of the sensor.  
 
4. Check to see if the indicator lamp numbered 0 in the lower right of the 

PLC lights up. Adjust the sensor so that the lamp does light. 
 
5. Place the block with that same piece of square stock in it on the conveyor 

one foot away from the sensor 6377-A0 (diffuse photoelectric).  
 
RSLogix Windows, Tool Bar, and Menus 
 
There are two windows that open when you start RSLogix: Project and Ladder 
Logic Diagram. 
 
You use the Project window to select Help, Controller, and Program files. The 
Ladder Logic Diagram window is where you build your program diagram. It allows 
you to add, delete, or insert rungs; add or delete branches; and delete or edit 
controls.  
 
6. Click on the down arrow next to the word "Offline." 
 
7. Click on Download. The computer downloads the program to the PLC. 

Click Yes on all prompts. 
 
8. On the conveyor, press the power switch on the left side of the control 

panel to turn the power on. The switch will light and the conveyor belt 
will begin to move. 

 
9. When the stock passes in front of the sensor connected to Channel 0 on 

the sensor box, the conveyor stops. 

NOTE:  When a normally closed instruction in the PLC 
receives a signal from the sensor, it stops the conveyor. 
When the conveyor stops, you will see the closed circuit 
rung, which was highlighted on your screen, darken. 
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10. Shut down the power switches on the conveyor, power supply, and PLC. 
 
11. Go to the File menu and click on Exit.  
 
12. Click on the Return button. The Directions window closes. 
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TOPIC 2 – RSLOGIX PROGRAMMING 

Objective 

When you have completed this topic, you will have gained the knowledge necessary 
to program timers, counters, math, and compare functions in RSLogix. 
 

Overview 

Programmable logic controllers can perform more tasks than just checking inputs 
and energizing outputs. You will see how RSLogix and a PLC can be used for other 
functions such as counting, timing, and mathematics. You will learn how numbers 
are stored and used by different functions. You also will become familiar with the 
Project Tree files, editing, downloading, and other elements of RSLogix. 
 

New Terms and Words 

bit – a spot in PLC memory that holds the ON/OFF status of a particular function.  
Bits are labeled 1 for ON and 0 for OFF. Bits can also be used as inputs anywhere 
in a ladder diagram. 
mechanical limit switch – a switch that requires physical contact in order to 
sense the presence of an object. The lever must move far enough to change the 
position of a switch within the device. 
noninteger– a number that is not whole, such as 1.234, 1 ¾, 5.5. 
synchronous – starting and stopping at timed intervals. 
solid state – devices that use semiconductors and electronic components instead of 
mechanical relay contacts. 
thumbwheel switch – a device that allows you to input numerical digits. 

Equipment Required 
PLC Sensor Trainer 
Conveyor 2001 
RSLogix 500 
RSLinx Lite  
Block 2 x 2 x 1½ in. (5) 
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Activity 1 – Using Timers 

Objective 

When you have completed this activity, you will have the knowledge and skills to 
program a timer in RSLogix. 
 
You will be able to: 
 
• program and address inputs and outputs in the timer rung. 
• program the Timer On-Delay function.  
• use the sensors and conveyor with the timer function. 

Procedures 

 
Setting up Programming 
 
Before you begin programming, you must know which input and output devices will 
be used. This will reduce confusion when addressing. 
 
In this activity, you will be using the fiber optic sensor as the input and the 
conveyor as the output. Locate these items now. 
 
Before you continue, make sure that the power to the PLC, the conveyor, and 24V-
power supply is turned off. 
 
Plug the cable from the fiber optic sensor into connection 0 on the back of the sensor 
interface box. This is automatically connected to input 0 of input module 0. 
Therefore, the address of this input is I:0/0. 
 
Keep in mind that there are 12 inputs available on this SLC 500. Their addresses 
are I:0/0 to I:0/11. Remember that the first 0 signifies the first input module. 
 
Next, using one of the shorter wires provided, connect Output 0 of the PLC to the 0 
input connection on the voltage level converter. Make sure you are plugging into the 
24V-> 5V section of the converter. This step is very important, it converts the 24V 
output of the PLC into 5V, which is compatible with the conveyor. If you do not do 
this properly, you may damage the conveyor motor. 
 
Then, connect the other 0 connection of the voltage level converter to the remote 
input on the front panel of the conveyor. Make sure you put this wire in the purple 
hole in the Motor section. Also make sure that the switch next to the holes is set to 
Remote. 
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Double check to make sure that the power leads are connected from the 24V power 
supply to the red and black power connections on the output module of the PLC. If 
not, make these connections. 
 
Next, connect a wire from the ground (black) connector on the power supply to the 
black connector on the conveyor motor. Again, make sure that it is connected to the 
black hole just under the purple hole in the Motor section. 
 
Your hardware is now setup to for this portion of this activity. 

Directions Window #1-1 

1. Open RSLinx by double-clicking the RSLinx.exe icon on the desktop. (You may 
need to drag the windows on the screen to find the icon.)  

2. Click on the minimize button in the RSLinx window. 
3. In the RSLogix 500 Starter window, click on the File menu, select New. *If a 

message asks you if you want to close a processor or save changes, click Yes (this 
message may not appear). 

4. In the Select Processor Type window, scroll to the bottom of the list and select 
processor number 1747-L20C/F. 

5. Click on the User tab in the editing toolbar so that it turns white. 
6. Click once on the Insert Rung icon, which is the first icon above the User tab. 

A new rung should appear, and small e's in a red box become visible to the left of 
it. 

7. Click on the Normally Open (XIC) Contact icon in the editing toolbar. This is 
the third icon from the left. An XIC instruction should appear on the first rung. 

8. Next, click on the Timer/Counter tab so that it is white, then click TON, the 
first function in the toolbar. A timer should appear on the right side of the rung. 

9. Click on the XIC Instruction so that a black bar with a question mark appears. 
Give the instruction the address of the fiber optic sensor. Type "I:0/0". 

10. Click on the question mark in timer function so that a black bar appears. This is 
how you give the timer an address. Type "T4:0". 

11. Press Enter, select the Time Base value and select 0.01 as the time base, and hit 
Enter. 

12. In the Preset value field, type 1000, then hit Enter. 
13. Do not type any values into the Accum value area. 
14. Now verify the rung by clicking on the Verify icon at the top of the toolbars. It 

looks like a computer with a green checkmark on it. Your ladder should not have 
any errors, if there are errors, close without saving and start over. 

15. Goto the File menu, select Save As, and type "Timer On". 
16. Look at the top left area of the screen under the File menu. Click on the arrow 

next to the word "Offline" and select Download. If any dialog boxes appear, 
click Yes. 
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17. If the processor is not in the Remote Run mode at the top left of the screen, 
click on the arrow next to Remote Prog. Select Run from the menu. The rails 
of the ladder should now be green. 

18. Place your hand in front of the fiber optic sensor and hold it there. The input 
I:0/0 should now energize (you can see this because the instruction will turn 
light green) 

19. Look at the Accum value in the Timer. This number will increase until it reaches 
1000. When 1000 is reached, remove your hand from the front of the fiber optic 
sensor. 

20. Place your hand in front of the sensor again, wait until the count reaches 500, 
and then take your hand away. You should notice that timer reset itself when 
you pulled your hand away. 

21. Now, hold your hand in front of the sensor until 1000 is reached, remove your 
hand, and place it back in front. Become aware of the way the timer functions 
when its input logic is true (energized) and not true (de-energized). 

22. When you have finished examining the Timer, click on the File menu, and select 
Exit. 

 
Click the Return button. Continue to the next page to resume the activity. 
 

Directions Window #1-2 

1. If RSLinx is not open, open it from the desktop, minimize it, and go back to 
RSLogix.  

2. Go to the File menu in RSLogix, and select Open. Double click on the file Timer 
On. 

3. Click on 0001 in the ladder diagram to make the red box appear just to the left 
of the rung. 

4. Click on the User tab so it is white, then click on the New Rung icon 3 times. 
Remember, the New Rung icon is the first icon above the User tab. 

5. Now, click on Rung 0001 again, then click on the Normally Open Instruction 
(XIC) icon.  

6. Click on Rung 0002, click on the XIC icon. Repeat for Rung 0003. 
7. Next locate Output Energize Instruction icon, which is the 5th icon above the 

User tab. Click and drag the icon into the ladder and drop it on the red box at 
the end of rung 0001. The red box will turn green to let you know that this 
instruction can go here. Repeat this step for rungs 0002 and 0003. 

8. In the Project Tree, double click on the T4-Timer file, under the Data Files 
folder. Move the window that opens so it is not blocking the inputs you just 
added to the ladder. You will use this window to assign addresses to the inputs. 

9. Click on the 0 under the EN in the first timer element. This is called the EN bit. 
(T4:0 is considered the first timer "element.") 

10. Drag the 0 to the instruction on rung 0001 and let it go when the red box turns 
green. 
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11. Click on the TT bit (the zero under TT) and drag that to the input instruction on 
rung 0002. 

12. Click and drag the DN bit to the input of rung 0003. Now you can close the Data 
File T4 window by clicking on the X in the upper right hand corner. 

13. In the Project Tree, double click on the O0 – Outputs File. Make sure that the 
window does not block the outputs on rungs 0001, 0002, 0003. 

14. Click on Bit 1 (the zero located under the 1 column heading) and drag it to the 
output instruction of rung 0001. 

15. Click on Bit 2 (the zero located under the 2 column heading) and drag it to the 
output instruction of rung 0002. 

16. Click on Bit 3 and drag it to the output instruction of rung 0003. 
17. Close the Data File - O0 window. 
18. Verify the new rungs by clicking on the Verify icon at the top of the menu bar. 

(The icon looks like a computer with a green checkmark in front of it.) There 
should not be any errors in your program. If there are, close the file without 
saving and start again from step 1, you must have missed something. 

19. Select Save As from the File menu and type "Timer On1." 
20. Download the program to the processor by clicking on the arrow to the right of 

Offline and selecting Download. (You do this right below the File menu) Click 
Yes when prompted by any dialog boxes. 

21. If the processor mode is not Remote Run, change it from Remote Program to 
Run. (Do this in the same area as step 19). 

22. Place an object, or your hand, in front of the fiber optic sensor and leave it there. 
You should notice that the inputs to rungs 0001 and 0002 are on while the timer 
is accumulating. When the timer stops, the inputs to rungs 0001 and 0003 are 
energized. 

23. Notice that as long as your hand is in front of the sensor, the EN bit is energized. 
24. Notice that while your hand is in front of the sensor and the timer is 

accumulating, both the EN and TT bits are energized and the DN bit is de-
energized. 

25. Notice that when your hand is in front of the sensor and the timer is finished 
timing, both the EN and DN bits are energized and the TT bit is de-energized. 

26. Notice that when nothing is in front of the sensor, none of the bits are energized. 
 

Directions Window #1-3 

1. If RSLinx is not open, open it from the desktop, minimize it, and go back to 
RSLogix.  

2. Go to the File menu in RSLogix, select Open, and double click on the file Timer 
On1. 

3. You will now learn some editing functions of RSLogix. You will edit this ladder 
to meet the conditions in your plan. 
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4. In the first rung, the input I:0/0 is the correct input for this process. The timer is 
the right one, but you need to change 1000 to 500. Click on the value, and type 
500. This sets the timer for 5 seconds (500 x .01 seconds = 5 seconds). 

5. You know that you need to get rid of two rungs that are not used in this 
program, rung 0001 and rung 0003 (since the DN and EN bits will not be used). 
Right click on the number 0003 to the left of the rung, and select Delete from 
the pop up menu. Repeat this for rung 0001. 

6. Now, you are left with two rungs, but the input instruction on rung 0001 is not 
what you need, you need the normally closed (XIO) instruction. Right click on 
the normally open input T4:0/TT and select Change Instruction Type. 

7. Type XIO where you currently see XIC. This changes the instruction from 
normally open to normally closed. 

8. The output you will use is connected to O:0/0. The output on this rung is set for 
O:0/2, so you need to edit this instruction too. Click on the output instruction 
and type "O:0/0" and hit Enter. 

9. You have now programmed the ladder to meet the conditions of your plan. 
10. Click on the Verify icon at the top of the page. If any errors are present, close 

without saving and start over at number 1 of this Directions window. 
11. Go to the File menu, select Save As and type "Timer On2." 
12. Download the ladder to the PLC by clicking the arrow next to Offline and 

selecting Download. 
13. If any dialog boxes appear, click Yes. 
14. On the conveyor control panel, switch the Motor mode from Off to Remote. 
15. Make sure the sensor is positioned so that it senses the presence of an object 

moving down the conveyor. 
16. Place a block on the conveyor so that it moves toward the sensor. 
17. When the block passes in front of the sensor the conveyor stops. Notice that the 

timer is timing, and the normally closed instruction in rung 0001 is not 
energized. 

18. When the 5 seconds is up, the normally closed instruction in rung 0001 is 
energized, and the conveyor turns back on. 

19. You can pick up the block and place it back on the conveyor so that the program 
repeats. Or, you can use more than one block on the conveyor. 

20. Take time to watch the ladder function as the program is executed by the PLC. 
21. The conveyor will continue to run unless you move the switch on the conveyor 

control panel from Remote to Off. 
 
Click the Return button. Continue to the next page to resume the activity. 
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Activity 2 – Using Counters 

Objective 

When you have completed this activity, you will have the knowledge and skills to 
program a counter in RSLogix. 
 
You will be able to: 
 
• program and address inputs and outputs in the counter rung. 
• use the counter function to initiate other events in a routine. 
• use the sensors and conveyor with the counter function. 

Procedures 

None required. 
 

NOTE:  In the following Directions, you will be asked to 
"Click here" sometimes to see a graphic. In those 
instances, you will have to maximize the Directions 
window on screen to follow the instructions. 

Directions Window #2-1 

1. Open RSLinx by double-clicking the RSLinx.exe icon on the desktop. (You may 
need to drag the windows on the screen to find the icon.)  

2. Click on the minimize button in the RSLinx window. 
3. In the RSLogix 500 Starter window, click on the File menu, select New. *If a 

message asks you if you want to close a processor or save changes, click Yes (this 
message may not appear). 

4. In the Select Processor Type window, scroll to the bottom of the list and select 
processor number 1747-L20C/F. 

5. Click on the User tab in the editing toolbar so that it turns white. 
6. Click twice on the Insert Rung icon, which is the first icon above the User tab. 

Two new rungs should appear. 
7. Select the first rung, 0000, and click on the Normally Open (XIC) Contact 

icon in the editing toolbar. This is the third icon from the left. An XIC 
instruction should appear on the first rung. 

8. Select the second rung, 0001, and click on the Normally Open (XIC) Contact 
icon in the editing toolbar. 

9. Click on the input instruction in rung 0000. Click on the Timer/Counter tab so 
that it is white, and click CTU, the fourth function in the toolbar. A counter 
should appear on the right side of the rung. 

10. Select the input instruction in the second rung, 0001, and click the RES button. 
This places the reset output on the end of the rung. 
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11. Click on the XIC instruction in rung 0000 so that a black bar with a question 
mark appears. Give the instruction the address of the fiber optic sensor. Type 
the following: I:0/0 

12. Click on the question mark in the counter function so that a black bar appears. 
This is how you give the counter an address. Type "C5:0". 

13. In the Preset Value field, type "10", then hit Enter. 
14. Do not type any values into the Accum value area. 
15. Click on the XIC instruction in rung 0001 and type "C5:0/DN". This instruction 

will energize when the counter reaches the preset. 
16. Click on the RES output in rung 0001. Type "C5:0". This tells the PLC to reset 

counter C5:0 whenever the input logic to this output is true. 
17. Now verify the rungs by clicking on the Verify icon at the top of the toolbars. 
18. Go to the File menu, select Save As, and type "Counter". 
19. Look at the top left area of the screen under the File menu. Click on the arrow 

next to the word Offline and select Download. If any dialog boxes appear, click 
Yes. 

20. If the processor is not in the Remote Run mode at the top left of the screen, 
click on the arrow next to Remote Prog. Select Run from the menu. The rails 
of the ladder should now be green. 

21. With your fingers together, move your hand slowly across front of the fiber optic 
sensor. The input I:0/0 energizes and de-energizes. You may not see this if you 
move your hand too fast. Move your hand slowly again and watch the input. 

22. Look at the Accum value in the Counter. This number will increase until it 
reaches 10.  

23. Move your hand back and forth until the counter reaches 10. Notice that after 9 
is reached, the Counter is reset to 0. 

24. Take some time to watch the Counter while passing your hand at different 
speeds across the sensor, with your fingers closed and spread apart. You may 
notice that the counter counts each of your fingers when they are spread apart. 

25. When you have finished examining the Counter, click on the File menu, and 
select Exit. 

 

Directions Window #2-2 

1. If RSLinx is not open, open it from the desktop, minimize it, and go back to 
RSLogix. 

2. Turn on the power to the PLC, 24V power supply, and conveyor. Make sure the 
Motor switch on the front of the conveyor control box is switched to Off. Also, 
make sure that the direction is switched to Forward. 

3. Go to the File Menu in RSLogix, and select Open. Double click on the File 
Counter. 

4. When the file opens, click on the Counter function and change the preset value 
to 5 by clicking on the 10 and typing 5. 
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5. In rung 0001, right click on the XIC instruction and select Change Instruction 
Type. Type XIO to change the instruction to a normally closed contact. 

6. Right click on the RES Instruction and select Change Instruction Type. 
Type "OTE" to change the instruction to an output energize instruction. 

7. On the same instruction, click C5:0 and type "O:0/0". This changes the output to 
the conveyor connected to output 0 of module 0. 

8. Verify the ladder and save it as Counter1. 
9. Download the file to the processor (select Download from the window just below 

the File menu). Click Yes if any dialog boxes appear. 
10. Place 5 blocks 2 inches from each other in a line on the conveyor so that when 

the conveyor is turned on, the blocks travel toward the fiber optic sensor. Also 
make sure that the fiber optic sensor is in a position to sense the blocks from the 
side. 

11. Switch the conveyor motor switch from Off to Remote. The blocks should now 
travel toward the fiber optic sensor. 

12. Watch the counter accumulator to make sure each block in seen by the sensor. If 
a block is missed, put it back at the end of the line so it gets counted. 

13. When the counter accumulator reaches 5, the conveyor stops. You will notice 
that if you pass your hand in front of the sensor, the counter continues to 
accumulate. 

 
You also should notice that the DN bit assigned to the normally closed instruction 
remains energized. 
 
When you have finished examining the Counter, click on the File menu, and select 
Exit. 
 

Preparation for Programming the PLC 
For the next exercise in this activity, you will need to locate the diffuse sensor, 
#6377-A0.  
 
Turn off the power switches to the PLC, conveyor, and 24V power supply. 
 
Connect the sensor to input 1 of the sensor interface box. Position the sensor so that 
it will detect the block from the side. Also, position the diffuse sensor so that it is 
closest to the conveyor control panel. Move the fiber optic sensor #6378-A0 to the 
other end of the conveyor. 
 
Be sure there is enough room for all 5 blocks to pass the sensors without falling off 
the end of the conveyor. 
 
Next, locate one short wire and two long wires that can extend from the Voltage 
Level Converter to the front of the Conveyor Control Panel. 
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Using the short wire, connect Output 1 of the PLC to the 1 input connection on the 
voltage level converter. Make sure you are plugging into the 24V⇒5V section of the 
converter. This step is very important, it converts the 24V output of the PLC into 
5V, which is compatible with the conveyor. 
 

CAUTION: If you do not do this properly, you may 
damage conveyor components. 

Next, connect the output from the voltage level converter to the yellow connector of 
the conveyor motor Direction section on the conveyor control panel. 
 
Make a connection from the black (ground) connection of the PLC to the black 
connection just under the yellow connection on the conveyor control panel. 
 

Directions Window #2-3 

 
1. If RSLinx is not open, open it from the desktop, minimize it, and go back to 

RSLogix. 
2. Turn on the power to the PLC, 24V power supply, and conveyor. Make sure the 

Motor switch on the front of the conveyor control box is switched to Off. 
3. Go to the File menu in RSLogix, and select Open. Double click on the file 

Counter1. 
4. Click on the Insert Rung icon and drag a rung into the ladder diagram. Drop 

the rung in the red box that appears just above rung 0001. (Remember, the box 
will turn green to let you know that is the location where the instruction will be 
dropped.) 

5. Click once on the Insert Rung icon, a new rung will automatically appear below 
rung 0001. 

6. Click and drag the Normally Open (XIC) Instruction icon and drop it in the 
first red box that appears on rung 0001. Type "I:0/1" to give the instruction the 
address of the diffuse sensor. 

7. Click on the Timer/Counter tab. Click and drag the CTU button into the 
ladder and let it go on the right-most red box of rung 0001. 

8. Click on the question mark inside the new counter. Type C5:1, hit Enter, type 5, 
hit Enter again. Click here (Hot word in the Directions window) to see what the 
rung should look like at this point. 

9. Click on the User tab. Click and drag an XIC instruction and let it go on the red 
box in rung 0002. Give the instruction the address C5:0/DN. 

10. Click once on the input in rung 0002, then click once on the Branch icon (second 
from left). A branch will appear in rung 0002. Click and drag the vertical red box 
on the branch to the left of the input C5:0/DN. 

11. Click and drag the Normally Open (XIC) Instruction icon and drop it in the 
first red box that appears on the bottom line of the branch. 
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12. Type "C5:1/DN" to give the instruction an address. 
13. Click on the Timer/Counter tab. Click and drag the TON button to the red box 

on the right of rung 0002. 
14. Click on the question mark inside the timer and type "T4:0", hit Enter and select 

time base 0.01, hit Enter and type 500 for the preset value. Click Here (on 
screen) to see what the rung should look like at this point. 

15. Click once on the normally closed (XIO) instruction in rung 0003 and type 
T4:0/TT. Click Here (Hot word in the Directions window) to see what the rung 
should look like at this point.   

16. Click on 0003 on the same rung (so that the solid red box appears). Click on the 
User tab, and click the Insert Rung icon 4 times. 

17. Click and drag the Normally Open (XIC) Instruction icon and let it go on 
rung 0004. Repeat this for rungs 0005, 0006, 0007. 

18. As a precaution, you should save the file as Counter 2. 
19. Click on the XIC instruction in rung 0004, type "C5:1/DN". 
20. Click on the XIC instruction in rung 0005, type "C5:0/DN". 
21. Click on the XIC instruction in rung 0006, type "I:0/0". 
22. Click on the XIC instruction in rung 0007, type "I:0/1". 
23. Make sure the User tab is selected, and click and drag the Output Latch icon, -

(L)-, to the rightmost red box in rung 0004. Type "O:0/1". 
24. Click and drag the Output Unlatch icon, -(U)-, and drop it in the red box on the 

right of rung 0005. Type "O:0/1". 
25. Click on the Timer/Counter tab. Click and drag the RES button (second from 

right) to the right side of rung 0006. Repeat this step for rung 0007. 
26. Click on the RES instruction in rung 0006, type "C5:1".  
27. Click on the RES instruction in rung 0007, type "C5:0". Click Here (Hot word in 

the Directions window) to see what rungs 0004, 0005, 0006, 0007 should look 
like at this point. 

28. Verify and save the file and download it to the processor. If any errors were 
found, you should try to fix them or start over from a new file. 

29. Place 4 blocks 2 inches away from each other in a line down the length of the 
conveyor. Make sure the blocks lie in between the two sensors. 

30. Turn the switch on the front of the conveyor panel to Remote. 
31. Notice that when each block passes the sensor, the counter advances one count. 
32. When the fourth block is seen by the sensor, the conveyor stops. The timer 

begins counting for 5 seconds. When 5 seconds is up, the conveyor begins to 
travel in the other direction. Notice that the counter still counts the blocks 
moving in the opposite direction, even though it has reached its maximum. 

33. When the 4 blocks pass the sensor at the other end, the counter counts to 5, 
stops for 5 seconds, and reverses. This routine will run perpetually until the 
conveyor is switched from Remote to Off. 

 
Watch the ladder diagram a few times as the program is running. Take time to 
notice what happens in each rung. 
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Activity 3 – Math Functions 

Objective 

When you have completed this activity, you will have the knowledge and skills to 
program math functions in RSLogix. 
 
You will be able to: 
 
• describe the values needed to program a math function. 
• add a math function to the ladder diagram and insert the correct values. 
• program a compare function. 
• run a program that uses the math and compare functions. 

 

Directions Window #3-1 

1. Open RSLinx by double-clicking the RSLinx.exe icon on the desktop. (You may 
need to drag the windows on the screen to find the icon.)  

2. Click on the minimize button in the RSLinx window. 
3. In the RSLogix 500 Starter window, click on the File menu, select New. If a 

message asks you if you want to close a processor or save changes, click Yes. 
(This message may not appear.) 

4. In the Select Processor Type window, scroll to the bottom of the list and select 
processor number 1747-L20C/F. 

5. Click on the User tab in the editing toolbar so that it turns white. 
6. Click twice on the New Rung icon. Two new rungs should appear. 
7. Select the first rung, 0000, and click on the XIC icon. 
8. Select the second rung, 0001, and click on the XIC icon. 
9. Click on the Input Instruction in rung 0000. Type "I:0/0". 
10. Click on the Timer/Counter tab so that it is white and click CTU. A counter 

should appear on the right side of the rung. 
11. Click on the question mark in the counter function and type "C5:0". Hit Enter 

and type "20" for the preset and hit Enter. 
12. Under the User tab, click and drag the Rung Branch icon into the ladder and 

drop it on the red box to the left of the counter function in rung 0000. 
13. Click and drag the tall red box on the right leg of the branch and drop it in the 

red box on the right side of the counter function. 
14. To the left of the User tab, click on the triangle that points to the right until the 

Compute/Math tab is visible. Click on the Compute/Math tab. 
15. Click and drag the SUB button and drop it on the red square in the bottom line 

of the branch that you just inserted. 
16. Click on the question mark next to Source A in the counter function and type 

"20" and hit Enter. This is the constant that will be used in this program. 
17. Click on Source B and type "C5:0.ACC". The number that is in the C5:0.ACC 

register will be subtracted from Source A, 20. 
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18. Click on Destination and type "N7:0". The result of the subtraction will be 
stored in this integer register, N7:0. Click Here (Hot word in the Directions 
window) to see what rung 0000 should look like. 

19. Click on the input instruction in rung 0001 and type "C5:0/DN". 
20. Click on the Timer/Counter tab. Click and drag the RES button the red box on 

the right of rung 0001. Type "C5:0". 
21. Verify the program and save it as Math<your name>.  
22. Download the program to the processor and make sure the processor is in the 

Remote Run mode. If not, select Run by clicking on the arrow next to Remote 
Program. 

23. Pass your hand in front of the diffuse sensor a few times; this is called triggering 
the input. You should notice that the count increases by one. 

24. While triggering the sensor input, you should also notice that the value in 
Source B of the SUB function is identical to the Accum value of the counter. This 
is because they both are displaying the value held in the register C5:0.ACC. 
Double-click on the C5 - Counter file in the Project Tree to see this value in 
the register under the ACC column. 

25. Finally, you should notice that the value in the Dest (Destination) field 
decreases by one each time the counter increases by one. Double-click on the N7 
– Integer file in the Project Tree to see this value. 

26. When you are finished examining the SUB function and how it works, close 
RSLogix. 

Directions Window #3-2 

1. If RSLinx is not open, open it from the desktop, minimize it, and go back to 
RSLogix. 

2. Turn on the power to the PLC, 24V power supply, and conveyor. Make sure the 
Motor switch on the front of the conveyor control box is switched to Off. Also, 
make sure that the direction is switched to Forward. 

3. Go to the File menu in RSLogix, and select Open. Double-click on the file Math. 
4. Right click on the SUB function in rung 0000 and select Change Instruction 

Type. Type "CTU". 
5. Click on the 20 next to the word Counter in the new count up function. Type 

"C5:1". Hit Enter. 
6. Type "20" for the preset, hit Enter.  
7. Type "10" for the Accum, value and hit Enter. 
8. Right click on rung 0001 and select Delete. Click here (Hot word in the 

Directions window) to see what the ladder should look like at this point. 
9. Click on the New Rung icon 6 times.  
10. Click on the right arrow to the left of the User tab until you can click the 

Compare tab. 
11. Click and drag the EQU button into rung 0001. Type "C5:0.ACC" for Source A 

and "C5:1.ACC" for Source B. 
12. Click and drag the NEQ button to rung 0002.  
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13. Click and drag the LES button to rung 0003. 
14. Click and drag the LEQ button to rung 0004. 
15. Click and drag the GRT button to rung 0005. 
16. Click and drag the GEQ button to rung 0006. 
17. In rung 0001, click and drag the address C5:0.ACC to Source A in the NEQ 

function in rung 0002. 
18. Click and drag the address from Source A in 0002 to Source A in 0003. Then 

drag the address from 0003 to Source A in 0004, then from 0004 to Source A in 
0005, and finally from 0005 to Source A in 0006. 

19. Next, drag the address C5:1.ACC from Source B in rung 0001 to Source B in 
rung 0002. Then, drag it from rung 0003 to 0004, 0005, 0006. 

20. Click and drag an Output Energize (OTE) instruction onto the right side of 
rungs 0001 through 0006. 

21. Click on the OTE instruction on the right of rung 0001. Type "O:0/0". 
22. In the output of rung 0002, type "O:0/1". 
23. In the output of rung 0003, type "O:0/2". 
24. In the output of rung 0004, type "O:0/3". 
25. In the output of rung 0005, type "O:0/4". 
26. In the output of rung 0006, type "O:0/5". 
27. Verify the program and save it as Compare<your name>. 
28. Download the program to the processor. 
29. If the processor is in Run mode, skip to 30. If the processor is not in the Run 

mode, click the arrow next to Remote Prog and select Run. 
30. You should immediately notice that outputs 1, 2, and 3 are all energized. This is 

because the values of the counters in rung 0000 are being compared constantly. 
Since the value in C5:0/ACC is 0 and the value in C5:1/ACC is 10, Source A is 
less than Source B in all of the compare functions. Only the NEQ, LES and LEQ 
functions are energized since they are true. Study each compare function to see 
why or why not its output is energized. 

31. Click on the Accum value of the C5:0 counter and type "10". Three of the 
outputs should be energized. Since the Value in C5:0/ACC is now the same as 
the value in C5:1/ACC, the EQU, LEQ and GEQ compare functions are all 
energized. 

32. Click on the Accum value of the C5:0 counter again and type "15". Now you 
should notice that the NEQ, GRT and GEQ compare functions are all energized. 
Study them to find out why. 

33. When you are finished studying the compare functions, close RSLogix. 

Directions Window #3-3 

1. If RSLinx is not open, open it from the desktop, minimize it, and go back to 
RSLogix. 

2. Turn on the power to the PLC, 24V power supply, and conveyor. Make sure the 
Motor switch on the front of the conveyor control box is switched to Off. Also, 
make sure that the direction is switched to Forward. 
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3. In the RSLogix 500 Starter window, click on the File menu, select New. If a 
message asks you if you want to close a processor or save changes, click Yes. 

4. In the Select Processor Type window, scroll to the bottom of the list and select 
processor number 1747-L20C/F. 

5. Click on each rung number below to see how they should be programmed. Try to 
program the ladder by looking at every rung below. When you finish 
programming your rung, it should be identical to the rung graphic that you 
selected. If you want more detailed instructions on how to program this ladder, 
click the Next button. 

 
Rung 0000 
Rung 0001 
Rung 0002 
Rung 0003 
Rung 0004 
(The ladder diagram is on page 50) 

 
When you have completed programming the ladder, click the Next button and go to 
step 21. 
 
1. Select the User tab and click on the New Rung icon five times. 
2. Drag an XIC instruction in rung 0000 and give it the address I:0/0. 
3. Click on the Timer/Counter tab and drag a Count Up function to the right of 

rung 0000. Give it the address C5:0 and preset of 1. The rung should look like 
This. (Hot word in the Directions window). 

4. Click on the User tab, and place an XIC instruction into rung 0001 and give it 
the address I:0/1. 

5. Drag a Count Up function to the right of rung 0001. Give it the address C5:1 and 
preset of 1. Click Here. (Hot word in the Directions window) to see what the 
rung should now look like. 

6. Place an XIC instruction on rung 0002 and give it the address of the fiber optic 
sensor, I:0/3. 

7. Click on the Compare tab. Click and drag the NEQ button and drop it to the 
right of the XIC instruction in rung 0002. 

8. In Source A, type "C5:0.ACC". In Source B type "C5:1.ACC". 
9. Click the User tab and drag an OTE instruction to the right side of rung 0002. 

Give it the address B3:0/0.1 If you want to see what the rung should look like, 
click Here (Hot word in the Directions window). 

10. Place two XIO instructions on rung 0003, and give them the addresses B3:0/0 
and I:0/2.  

                                                 
1 This is referred to as a bit or internal relay, you may remember that they are found in the B3 – 
Binary File of the Project Tree. Internal relays function like an output, but there is no real output 
attached to it. Bits can be used elsewhere in the ladder as inputs. 
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11. Drag an OTE instruction to the right of rung 0003. Give the output the address 
O:0/0. This (Hot word in the Directions window) is what the rung should look 
like now. 

12. Drag one XIC and one XIO instruction into rung 0004. Give the XIC instruction 
the address I:0/3. Give the XIO instruction the address B3:0/0. 

13. Click on the Rung Branch icon and drag it to the leftmost red box of rung 0004. 
Click on the right side of the branch and drag it to the red box just to the right of 
the B3:0/0 XIO instruction. 

14. Place an XIC instruction on the branch and give it the address I:0/2. 
15. From the Timer/Counter tab, click and drag a Reset instruction to the right of 

rung 0004. Give it the address C5:0. 
16. Drag a Rung Branch to the red box just to the left of the RES instruction in 

rung 0004. Click on the right side of the branch and drag it to the right side of 
the Reset instruction. 

17. Drag a RES instruction to branch under C5:0 in rung 0004. 
18. Give the new RES instruction the address C5:1. Rung 0004 should now look like 

This (Hot word in the Directions window). 
19. If you haven't already, place five blocks on the conveyor about an inch from each 

other behind the conveyor control panel. Make sure that the diffuse and back 
suppression sensors can accurately count the blocks. Also make sure that the 
motor switch on the conveyor panel is set to Off. 

20. Switch 1 (Hot word in the Directions window to show graphic) on top of the 
sensor interface box is a reset switch. If something goes wrong while trying to 
setup the program, turn the conveyor motor switch to Off and then turn switch 1 
off, then on again, and start over. 

21. Verify and save the file as Compare1<your name> and download it to the 
processor. 

22. If the processor is in Run mode, skip to 23. If the processor is not in the Run 
mode, click the arrow next to Remote Prog and select Run. 

23. Turn the motor switch on the front of the conveyor control panel from Off to 
Remote. 

24. Watch the C5:0 counter Accum value to make sure that all blocks are counted. If 
all five are not counted, turn the conveyor motor switch off and put the blocks 
back in the starting position and make the necessary changes so that all five 
blocks will be counted. To reset the counter, flick the switch on the top of the 
sensor interface box on then off again after you figure out why the blocks are not 
counted. 

25. Once all five blocks pass the diffuse sensor, watch the ladder diagram. All five 
blocks should pass the sensor, they should continue until all of the blocks pass 
the fiber optic sensor and fall off the end of the conveyor. This is simulating a 
process that moves verified sets of pieces from one conveyor to another. 
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26. When all pieces are present, the counters should reset automatically. If not, 
reset the timer and counters by moving the switch on top of the sensor interface 
box from Off to On to Off again. Turn the conveyor Motor switch from Remote to 
Off and replace the blocks in the starting position. 

27. Start the conveyor. When all five blocks pass the first sensor, take one off the 
conveyor.  

28. You should notice that the conveyor stopped when the first block reached the 
fiber optic sensor. This is because the B3:0 output of rung 0002 is energized 
when the NEQ compare function is true. This turns off the XIO instruction in 
rung 0003, which stops the conveyor, O:0/0. 

29. If this were a continuous operation in a manufacturing facility, the conveyor 
would need a manual reset when a block is missing. This guarantees that 
someone knows that parts are missing on the line and will remove the set, and 
restart the process. 

30. If all five blocks are present in both locations, the conveyor continues to check 
every set of five blocks. When the fiber optic sensor senses the first block of a set 
of 5, the counters reset, allowing for continuous monitoring of the process. 

31. To reset the process, turn switch 1 on the on the sensor interface box off. Place 
the blocks on the conveyor in the starting position and turn switch 1 back on. 

32. Continue to place blocks on the conveyor and notice how the ladder diagram 
changes during the process. You will need to pay careful attention so that you 
can successfully complete the authentic assessment for this activity. You may 
perform this exercise with 2 or more blocks. 

33. When you are finished studying this system, close RSLogix. 
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This is the ladder diagram for Directions window #3-3. 
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TOPIC 3 – TASKING 

Objective 

When you have completed this topic, you will be able to create and use flowcharts to 
provide visual representations of manufacturing operations.  You will be gain the 
knowledge and skills necessary to initiate and program tasks using both the 5100 
and 5200 robotic systems.  
 

Overview 

Up to this point in your study of automation you have created isolated programs 
using individual components of your CELL system.  In this topic you will begin to 
learn and experiment how your individual components can work as systems.   
 
The reaction of system component to an input state is the basic premise of system 
interaction and control. The use of programming statements that will decide the 
sequence of events that will take place in a system will be explored and 
experimented.   

New Terms and Words 

conditional statements - an event that is dependent on the state or condition of 
one or more variables. 
articulating -  a robot configuration similar to the human arm. 
tendon technology – the use of cables and springs to adjust tension on the 
gripper. 
charts - can mean map, table, graph, or diagram. Here we mean a graphic which 
doesn't use numerical interpretation 
hierarchy -  the organization of persons or things according to rank, order, grade, 
or class. 

Equipment Required 
5200 Robot mounted on Linear Slide 
5100 Robot 
Conveyor  
Conveyor limit switch and mounting hardware 
Connecting wires 
Pneumatic feeder 
Delrin block 2 X 2 X 1½  (1) 
Delrin rods ¾ X 2½ in (5) 
Student Guide/Portfolio 
LEVEL 4 ROBOTIC SOFTWARE 
Blank floppy disk 
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Activity 1 – Flowcharts in Manufacturing 

Objective 

When you have completed this activity, you will have the knowledge and skills to 
create flowcharts as visual representations of manufacturing operations. 
 
You will be able to: 
 
• use the basic methods of flowcharts to portray an operation. 
• read flowcharts without difficulty. 
• explain how flowcharts are used. 
• understand other types of charts. 
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Activity 2 – Creating a Task with the 5200 

Objective 

When you have finished this activity, you will have the knowledge and skills 
necessary to initiate tasks using Level 4 Robotic Software. 
 
You will be able to: 

• create a points program from the 5200 teach pendant. 
• upload a points program from the teach pendant into Level 4 Robotic 

Software. 
• add input and output conditions to your program. 
• implement conditional statements into your program. 
• control the conveyor system from your program. 
• compile and run your program from Level 4 Robotic Software. 
 

Directions Window #2-1 

1. Click on File and then click on New. 
 
2. In the Program Information dialog box, click in Author. 

 
3. Hit Backspace or Delete on your keyboard until Student is erased. 

 
4. Type in your full name under Author. 

 
5. Click on Project. 

 
6. Type in Project #1. 

 
7. When you are completed filling in the information, click on OK. 

 
8. Click on Robot and than click on Online.  This will transfer your robot from 

teach pendant control to computer control. 
 

9. Click on Window and than click on Point Editor.  This will bring up the 
Level 4 point editor window.  All robot control happens in this window. 

 
10.  Click on Robot, click on Upload to and than click on Point Editor.  This 

will upload your point program from the teach pendant into the level 4 point 
editor.  A dialog box will open during the download, keep your cursor arrow of 
your mouse inside this box. 

 
11.  From the Point Editor window you can execute the points.  Double click on 

HOME.  Home should be highlighted and the cursor should be pointing to it. 
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12.  Click on Execute on the menu, the program will now run your point 

program. 
 

13.  When the points program has completed.  Double click on HOME. 
 

14.  Click on MOVEROBOT1 then click on Move on the menu.  The robot will 
move to that position. 

 
15.   Now click on MOVEOVERBLK then click on Move.  The robot will now 

move to this position.  
 

 You now need to get the point program over to the program window. 
                           

           
 
 

16.   Click on MOVEROBOT1 and drag and drop it over to the right side of the 
program window.  This is the right side of the window with the white not 
blue background. 

 
17. Continue to drag and drop all the points over to the program window. 
  
Now you are ready to program the task. 
 
18. Click on the END statement on line 00001.  Hit Backspace or Delete on 

your keyboard until END is erased. 
 
19.  Type the following on line 00001: HOME 
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20.  Type the following on line 00002: OUTPUT (1) OFF 

 
21.  Type the following on line 00003: MOVETO MOVEROBOT1 

 
22.   Type the following on line 00004: WHILE INPUT (1) LOW 

 
23.   Type the following on line 00005: OUTPUT (2) ON 

 
24.   Type the following on line 00006:  OUTPUT (1) ON 

 
25.   Type the following on line 00007: INPUT (2) LOW 

 
26.   Type the following on line 00008: OUTPUT (1) OFF 

 
27.   Type the following on line 00009: SPEED 49 

 
28.   Type the following on line 00010: MOVETO MOVEOVERBLK 

 
29.   Type the following on line 00011: SPEED 99 

 
30.   Type the following on line 00012: MOVETO OPENGRIPPER 

 
31.   Type the following on line 00013: MOVETO ADJBLOCK1 

 
32.   Type the following on line 00014: SPEED 49 

 
33.   Type the following on line 00015: MOVETO ADJBLOCK2 

 
34.   Type the following on line 00016: MOVETO CLOSEGRIPPER 

 
35.   Type the following on line 00017: MOVETO PICKBLOCKUP 

 
36.   Type the following on line 00018: MOVETO PUTBLKDOWN 

 
37.   Type the following on line 00019: MOVETO PLACEBLK 

 
38.   Type the following on line 00020: MOVETO OPENGGRIP2 

 
39.   Type the following on line 00021: SPEED 99 
40.   Type the following on line 00022: MOVETO MOVEAWAY 

 
41.   Type the following on line 00023: IF INPUT (1) LOW 
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42.   Type the following on line 00024: REPEAT 
 

43.   Type the following on line 00025: ENDIF 
 

44.   Type the following on line 00026: RESTART 
 

45.   Type the following on line 00027: END 
 
Now that you have entered your program, you must save it. 
 

46.  Click on File and then click on Save as.  In the Save as dialog box, type in 
your name (example: Gabriella Smith) and then click Save. 

 
47.  To compile your program, click on Robot and then click on Compile.   

 
48.   Set the conveyor MOTOR and DIRECTION to REMOTE set the conveyor 

speed to very slow. 
 

49.   Set a block onto the conveyor near the conveyor limit switch.  
 

50. To run your program, click on Robot and then click on Run. 
 

51.   A Run Point dialog box will open, keep the cursor arrow of your mouse 
inside this box. 

 
You will see that the robot will move from its HOME position to position 
MOVEROBOT1.  You should notice that the program will loop between the WHILE 
and REPEAT statement as long as the Start Switch is HIGH. 
 

52.  Toggle the Start Switch to make it go low, the CHANNEL 1, INPUT LED on 
the front of the controller will go out.   

 
The robot will now continue with the program, it will continue to pick-up and place 
the block away from the conveyor limit switch as long as the start Switch is low.  If 
you set the start switch to high, the robot will go back to its wait state. 
 

53. To stop the program click on Cancel. 
 
54. Click on File and then click on Exit. 

 
55. Click on Return to return back to your activity. 
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Activity 3 – Creating a Task with the 5100 

Objective 
Upon completion of this activity, you will have the knowledge and skills necessary 
to initiate tasks using inputs with the Armdroid 5100. 
 
You will be able to: 
 
• program inputs to initiate tasks using the Armdroid 5100 teach pendant. 
• save programs to the computer using the 5100 Server software. 
• turn an output on and off using control points. 
 

Directions Window #3-1 

1. Set the serial switcher to B so that the computer can communicate with the 
5100.  

2. The first window that opens verifies that the file directory is Data and the 
communications port is COM1. Click OK. 

3. Double click on the Green icon in the system tray (lower right) on the Windows 
task bar. A small window should appear. There are three fields in the window. 
This window should be visible whenever attempting to load or save a file. If a 
screen saver appears when you try to save or load, you will not be able to see the 
files on the teach pendant. 

4. Turn on the Armdroid 5100 power supply. You should see Lab-Volt Inc. 
Armdroid 1001 Version 1.02.00 on the startup screen of the teach pendant. 
Press any key to get to the Main menu. 

5. Press the Teach Menu key. 
6. Program the Armdroid so that the entire arm points straight upward. Record 

this point. 
7. Press the Main Menu key. Select menu item number 2 (Execute). Select 1 

(Once). 
8. When the program is complete, press the Main Menu key. Select 5 File I/O. The 

Armdroid immediately looks for the server. 
9. Next, select 2 (Save) from the menu. Since you are saving a new file, select 1, 

(New File). 
10.  A window will open on the screen of the PC, in front of the 5100 Server window 

that is normally visible. Type in the name of the file here, Act31. Use your 
initials or the first 3 letters of your name in the file name, such as “Act31Dav” 
or something similar. When you have typed the name, hit Enter. 

11. The program is now saved on the hard drive of the PC. It can be loaded into the 
Armdroid memory at anytime. 

12. Turn the Armdroid power switch off and then on again. The memory is now 
cleared. 

13. From the Main menu, select 5 File I/O. Press 1 Load. 
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14. Press the number that has the file you just saved listed next to it. 
15. After a few seconds, when the message on the pendant no longer reads “recv,” 

press the ESC key, then the Main Menu key. 
16. Select 2 Execute, then 1 Once. 
17. Once the program has been executed, click the Return button. Continue to the 

next page to resume the activity. 

Directions Window #3-2 

1. Turn on the 5100 power supply. You should see Lab-Volt Inc. Armdroid 1001 on 
the startup screen of the teach pendant. 

2. Press any key to go to the Main menu. 
3. Press the Teach Menu key. 
4. Position the robot so that the gripper is about 8 inches above the rod in the 

pneumatic feeder. 
5. Press the Main Menu key. 
6. Select menu item 3, Initial. This brings up the Initialize menu. 
7. Select 1, Reset Home, then select 1 Yes. The position it is in now is the home 

point. 
8. Open the program you just saved. In the Main menu, select 5 FileI/O. Then, 

select 1 Load, and select the file Act31<yourname>. 
9. Press ESC, then the Main Menu key and select 2 Execute, then 1 Once. 
10. You should notice when the robot stops that it does not point directly upward as 

you had programmed it to do before it goes back to the home position. Since the 
home point was changed, the robot cannot perform the routine you intended it 
to perform. You will have to reprogram it with the current home setting if you 
wanted it to point toward the ceiling. 

11. Make sure the robot is home, shut it down, start it up, and reset the home 
position. 

12. Press the Teach Menu key. Program the Armdroid to go to the straight up 
position again. Don’t forget to record the point. 

13. Save the program by doing the following. Press Main Menu key, select 5 File 
I/0, select 2 Save, then select 1 New File. On the PC, name the file ACT32<3 
letters of your name>. 

14. Press ESC, then the Main Menu key. Select 3 Initial, then select 2 Move 
Home. 

15. Turn off the power to the Armdroid, then switch it on again. 
16. Press any key to get to the Main Menu. 
17. Select 3 Initial, then select 1 Reset Home, then 1 Yes. Now the robot is in the 

same starting position as it was when you programmed it. 
18. Press the Main Menu key, select 5 File I/O, then 1 Load. Select the file that 

you just saved. 
19. Press ESC, then the Main Menu key, select 2 Execute, then 1 Once. 
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20. The Armdroid should go to the straight up position. This is because you 
returned the robot to its home position when you shut down, and reset the home 
position when you switched it back on. You must remember to do this every time 
you shut down and start up the robot. If you don’t do this, all of your saved 
programs will not run properly. 

21. Make sure the robot is back to its home position (select Move Home in the 
Initial option of the Main menu) and turn the power off. Don’t forget to save 
this as the home position as soon as the robot is switched on. 

Procedure 

Make sure the pneumatic feeder is connected properly, according to this CELL 
guide. Connect the NO yellow wire output and black ground from the end of the 
pneumatic feeder to input 3 and ground, respectively, of the 5100 robot control box. 
The yellow wire and black wire should come from the same microswitch (there are 
two microswitches at the end of the pneumatic feeder). There should not be any rods 
loaded into the feeder yet.  
 
Place a two-holed block on the conveyor behind the conveyor control panel. The 
5100 should be able to easily reach the block to place the rod in one of the holes. 
 
Turn on the Armdroid 5100, and save the home position before doing anything else. 
(Main menu, 3 Initial, 1 Reset Home, 1 Yes) 
 
The default mode of the 5100 has tasking turned off. You must select a task number 
for a program in order to turn tasking on. 
 
In the Main menu, select 6 Setup. 
 
In the Setup menu, choose 2 Select Task (1-4). 
 
Press 1 to select task 1. Remember, tasks 1-4 are initiated using inputs 3-6 on the 
5100 controller. Inputs 1 and 2 cannot be used to initiate tasks. 
 

NOTE: Once tasking is turned on, you will not be able to 
load files that were created when tasking was turned off. 
You will only be able to load files without tasks when 
tasking is off. 

 
Press the Teach Menu key to begin programming the points for task 1. 
 
Place a rod in the pneumatic feeder. Using the teach keys, program the 5100 to pick 
up the rod from the pneumatic feeder and place it in the hole in the block. 
Remember to record each point using the Data <.>(dot) key. 
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You do not have to program any special commands to get the robot to wait for the 
input 3 signal. The robot automatically will wait until input 3 goes from hi to low. If 
a rod is in the pneumatic feeder when you run the program, the 5100 will start 
immediately. If not, a screen will appear with the words “Waiting for Tasks.” 
 
When you are finished programming the task, go to the Main menu and select 2 
Execute. The Waiting for Tasks screen will appear.  
 
Load a rod into the pneumatic feeder. When the rod is ready to be picked up, the 
5100 should begin task 1. 
 
Once the task is complete, you should save the program. Click the Launch button 
to open the 5100 Server software. 

Directions Window #3-3 

1. Hit the ESC key, then go to the Main Menu, select 5 File I/O. 
2. Select 2 Save from the File I/O Menu, then 1 Newfile. 
3. Type in the file name Act33<your name> in the window that opens on the PC 

screen, click OK. 
4. Send the 5100 to the Home position and shut down the power supply. 

Procedure 

If you look at the robot’s base, you’ll notice that there are four color coded outputs 
with green grounds. From left to right, these are outputs one through four. Outputs 
1 and 2 are normally on, and outputs 3 and 4 are normally off. 
 
On the base of the 5100, connect a wire to the green ground jack of the third output. 
Connect another wire to the orange output just above the output 3 ground. Click 
here2 to see these connections. 
 
Connect the other ends of the wires to the inputs of the conveyor Motor section. 
Make sure the wire connected to the black jack on the robot is connected to the 
black jack on the conveyor control panel. Set the Motor switch on the conveyor 
control panel to Remote. The Direction switch should be set to the Forward position. 
Place a block on the conveyor, within reach of the 5100. 
 
Next you are going to program the robot to pick up a rod from the pneumatic feeder, 
and place it in the block on the conveyor. The 5100 will then turn the conveyor on. 
 
Power up the 5100 and save the home position. Also, turn on the power switch to 
the conveyor. 
 

                                                 
2 [Pop-up graphic – Show picture of connections to the robot outputs.] 
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In the Main menu, select 6 Setup, then 2 Select Task, then select Task 1. 
 
Go to the Teach menu and program the robot to pick up the rod and place it in the 
block on the conveyor. Remember to record each point. 
 
Once the rod is in the block and the gripper is moved away, press the Output key on 
the teach pendant. Press 3 to turn on output 3, so that the screen looks like This 
(hot word on screen). Press the Data dot <•> key to enter the point. The conveyor 
will start. 
 
Rotate the robot base so it points toward the pneumatic feeder. Record the point. 
 
Press the Output key, and then press 3 to turn the conveyor off. Record the point. 
 
Run the program. You may have to align the hole in the block under the rod as the 
robot approaches. 
 
Press the Launch button to open the 5100 File Server Software and save the 
program.  
 

Directions Window #3-4 

 
1. Hit the Esc key, then go to the Main menu, select 5 File I/O. 
2. Select 2 Save from the File I/O Menu. 
3. Type in the file name Act34<your name> in the window that opens on the PC 

screen, click OK. 
4. Send the 5100 to the home position and shut down the power supply. 
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TOPIC 4 – PLANT MANAGEMENT TODAY 

Objective 

When you have completed this topic, you will be able to identify flexible 
manufacturing cells and systems, computer-integrated manufacturing (CIM), and 
proportional, integral, and derivative (PID) controls. You will be able to explain the 
impact of computer-integrated manufacturing, what local area networks (LANs) 
and wide area networks (WANs) are, and how PID control works. You will also 
learn of the latest advances made in robotics. Finally, you will learn what fuzzy 
logic is and how it is applied. 

Overview 

This topic deals mainly with how modern computerized plants are organized and 
how they function as integrated units. 
 
Activity 1 carries flexible manufacturing a step or two further from Level 1. It talks 
about how flexible manufacturing developed. It introduces the idea of 
programmable logic controllers (PLCs) controlling flexible manufacturing cells and 
flexible manufacturing systems. It also opens a window on the advances made in 
robotics, including microrobotics, nanorobotics, and medical robotics. 
 
Activity 2 describes and evaluates computer-integrated manufacturing (CIM). It 
explains local area networks (LANs) and wide area networks (WANs) which CIM 
depends on to function. 
 
Activity 3 expands on industrial controls which were introduced in Level 1. In this 
activity, PID (proportional, integral, derivative) control is discussed along with the 
new approach called fuzzy logic. 
 
Put simply, Topic 4 provides a brief look at the status of manufacturing at the 
beginning of the 21st century. 
 
 
New Terms and Words 

algorithm – a formal procedure for any mathematical operation. 
analogies – comparisons between things that are similar yet not identical; 
similarities, likenesses. 
autonomous – capable of operating without outside control; self-contained. 
CNC – a self-contained numerical control (NC) system for a single machine tool 
that uses a dedicated computer, controlled by stored instructions to perform some or 
all of the basic functions of an NC machine. 
dedicated – given over to a particular purpose or function. 
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derivative – something  that comes from, grows out of, or results from a 
fundamental state or condition. 
distributive control – a design approach in which factory or machine control is 
divided into several subsystems, each managed by a unique programmable 
controller, yet all interconnected to form a single entity. 
femur – the longest and largest human bone, extending from the hip to the knee; 
thigh bone. 
gene therapy – the insertion of normal or genetically altered genes into cells, 
often to replace defective genes, especially in the treatment of genetic disorders. 
hysteresis – the lagging of a physical effect on a body behind its cause; for 
example, it is the time between a cause (a furnace is turned on) and its effect (the 
air temperature begins to rise). 
inertia – the tendency of matter to remain at rest or in uniform motion in the same 
straight line unless acted upon by some external force. 
innovation – bringing in new things or new ways of doing things. 
logistics – the handling of the details of a project. 
materials science – the scientific study of the properties and applications of 
materials of construction or manufacture such as ceramics, polymers, metals, or 
composites. 
microns – thousandths of a millimeter. 
nanometer – one billionth of a meter.  
nodes – receiving and/or transmitting stations such as computer terminals in an 
electronic communications network. 
oscillation – a swinging or moving back and forth; fluctuation. 
offset – discrepancy or deviation. 
PID – means proportional integral derivative.  
protocol – a set of conventions governing the treatment and especially the 
formatting of data in an electronic communications system; established rules of 
conduct. 
semantics – the study of meanings and the development of meanings of words. 
servo – refers to self-regulating feedback systems. 
solenoid – a coil of wire usually in cylindrical form that, when carrying a current, 
acts like a magnet drawing in a movable core (piston); used especially as a switch or 
valve. 
time integral – where the rate of change of the output signal is proportional to the 
input signal. 
topologies – configurations or shapes. 
viscosity – the property of resistance to flow in a fluid or semifluid. 

Equipment Required 

Graymark Model 602 Line Tracer Robot 
Tape, Electrical Vinyl ¾ in. 
 
 



Automation & Material Handling Topic 4 – Plant Management Today 

 
64

Activity 1 – Implementing Flexible Manufacturing Systems 

Objective 

When you have completed this activity, you will have the knowledge and skills to 
identify flexible manufacturing systems (FMSs) and their functions and explain the 
advances in robotics. 
 
You will be able to: 
 
• identify FMSs. 
• understand the relationship between an FMC and an FMS. 
• trace the organization of an entire modern industrial facility. 
• explain the latest advances in robotics. 
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Activity 2 – Computer-Integrated Manufacturing 

Objective 

When you have completed this activity, you will have the knowledge and skills to 
identify computer-integrated manufacturing (CIM), understand its functions, and 
explain its importance in modern industry. 
 
You will be able to: 
 
• recognize CIM and its place in the modern industrial world. 
• understand the relationship of flexible manufacturing cells (FMCs) and flexible 

manufacturing systems (FMSs) with CIM. 
• explain the functions of CIM. 
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Activity 3 – Process Control Strategies 

Objective 

When you have completed this activity, you will have the knowledge and skills to 
understand and explain PID and fuzzy logic. 
 
You will be able to: 
 
• explain the kinds of controls available in industry. 
• understand and explain how proportional, integral, and derivative function. 
• appreciate why certain controls do better than others in particular operations. 
• apply fuzzy logic to simple, practical situations. 
• recognize how fuzzy logic refines the industrial process. 
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Topic 5 – Troubleshooting an Automated System 

Objective 

When you have completed this activity, you will have the knowledge and skills to 
properly document and monitor ladder logic in RSLogix. 
 
You will be able to: 
 
• identify and insert symbols, address/instruction descriptions, rung comments, 

and titles. 
• use the online monitoring tools to view real time processes of the PLC. 
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Activity 1 – Documentation and Monitoring 

Objective 

When you have completed this activity, you will have the knowledge and skills to 
properly document and monitor ladder logic in RSLogix. 
 
You will be able to: 
 
• identify and insert symbols, address/instruction descriptions, rung comments, 

and titles. 
• use the online monitoring tools to view real time processes of the PLC. 

Procedures 

None required. 

Directions Window #1-1 

NOTE:  In the following Directions, you will be asked to 
"Click Here," sometimes to see a graphic. The hot word 
could be "This" to bring up a graphic. In those instances, 
you will have to maximize the Directions window on 
screen to see the graphics. 

1. Open RSLinx by double-clicking the RSLinx.exe icon on the desktop. (You may 
need to drag the windows on the screen to find the icon.)  

2. Click on the minimize button in the RSLinx window. 
3. In the RSLogix 500 Starter window, click on the File menu, select Open.  
4. Double click on the file Counter1<your name>. 
5. Right click on the white background between rungs and select Properties from 

the pop up menu. 
6. Click on the Comment Display tab. 
7. At the bottom of the window, make sure that the Show Symbol and Address 

button is selected. Click OK. 
8. Right click on the XIC in rung 0000 and select Edit Symbol. 
9. Type "Fiber Optic Sensor" and hit Enter. 
10. Using the same procedure, assign the XIO instruction in rung 0001 with the 

symbol Block Counter Done. 
11. Next, give the output of rung 0001 the symbol Conveyor. The ladder should now 

look like this. 
12. Now, add the address descriptions to the following addresses: 

I:0.0 – Block Sensor 
C5:0 Counter – Block Counter 
C5:0.DN – De-energizes when C5 is finished counting 
O:0.0 – Conveyor should stop when 5 blocks are present 
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13. Your ladder should now look like this. 
14. Add the following comment to rung 0000: Counter advances by one when Fiber 

Optic Sensor sees a block. 
15. Add the following comment to rung 0001: 5 blocks must be present for assembly. 

This is what your ladder should look like. 
 
Add this title to rung 0000: Delrin Block Counter. Your ladder diagram should look 
like this. 
 
Save the file as Docum1 <your name>. 
 
Open and examine the Project Tree files in the Database folder: Address/Symbol 
and Rung Comments/Page Title. Try to figure out how you can use these files to 
your advantage if you had to troubleshoot this program. 
 
When you have finished, click on the File menu and select Exit. 
 
Click the Return button. Continue to the next page to resume the activity. 

Directions Window #1-2 

1. Open RSLinx by double-clicking the RSLinx.exe icon on the desktop. (You may 
need to drag the windows on the screen to find the icon.)  

2. Click on the minimize button in the RSLinx window. 
3. In the RSLogix 500 Starter window, click on the File menu, select Open.  
4. Double click on the file Counter1<your name>. 
5. Insert this rung into the ladder after rung 0001. Include all the documentation. 

Remember, the RES instruction is found in the Timer/Counter tab. 
6. Verify and save the file, then download it to the processor. 
7. Set up the five blocks on the conveyor as you did in Topic 2, Activity 2. Place five 

blocks 2 inches from each other in a line on the conveyor so that, when the 
conveyor is turned on, the blocks travel toward the fiber optic sensor. Also make 
sure that the fiber optic sensor is in a position to sense the blocks from the side. 

8. Switch the conveyor Motor switch from Off to Remote. The blocks should now 
travel toward the fiber optic sensor. 

9. Watch the ladder diagram carefully while the process is underway. Read the 
descriptions and comments of instructions that energize. When all five blocks 
pass the sensor, switch the conveyor motor from Remote to Off.  Place the five 
blocks on the conveyor in the starting position. Switch the conveyor motor back 
the Remote position. When you pass your hand in front of the fiber optic sensor, 
the counter will reset and the conveyor will move. 

10. Open the following files from the Project Tree: C5 – Counter, O-0 Outputs, I-1 
Inputs. Place them on screen so that you can see all 3 windows. If any windows 
disappear behind the ladder, use the Window menu to bring them to the front. 
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11. Replace the blocks and switch the conveyor motor from Off to Remote. Study the 
process again using the data files to monitor the input, output and counter. You 
should notice that the only address you must watch in both the Input and 
Output tables is the address in the 0 column, the rightmost address. Watch the 
input status change from 0 to 1 as the ACC value in the Counter file 
accumulates at the same time. 

12. Continue to reset the counter and replace the blocks so that you can fully 
understand the documentation. 

13. When you have finished, click on the File menu and select Exit. 
 
Click the Return button. Continue to the next page to resume the activity. 

Directions Window #1-3 

1. Open RSLinx by double-clicking the RSLinx.exe icon on the desktop. (You may 
need to drag the windows on the screen to find the icon.)  

2. Click on the minimize button in the RSLinx window. 
3. In the RSLogix 500 Starter window, open the file Counter2<your name>. 
4. It is up to you to set up the system to work with this ladder diagram. You need 

the following devices to properly connect the system: 
 
  Diffuse Sensor 
  Fiber Optic Sensor 
  Sensor Interface 
  Voltage Level Converter (VLC) 
  PLC 
  24V Power Supply 
  Conveyor 
  5 Blocks 
 

HINT: The diffuse sensor is connected to input 1 of the 
sensor interface box. 

5. Check your final ladder diagram against the one in your CELL guide. They won’t 
be identical, but they should be close. 

 
If you need more hints, click on the component name above to see how the wires 
should be connected. Click the Next button to proceed. 
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Activity 2 – Troubleshooting the PLC and Field Devices 

Objective 

When you have completed this activity, you will have the knowledge and skills to 
troubleshoot the PLC system for connection or program errors. 
 
You will be able to: 
 
• determine the best starting point for finding programming errors, equipment 

malfunctions, or improper connections. 
• locate problems that prevent the system from operating properly. 
• repair the system so that it will function the way you intended it to. 

Directions Window #2-1 

1. Open RSLinx by double-clicking the RSLinx icon on the desktop. (You may need 
to drag the windows on the screen to find the icon.)  

2. Click on the minimize button in the RSLinx window. 
3. In the RSLogix 500 Starter window, click on the File menu, select New. Choose 

1747-L20C/F from the list of processors. 
4. Insert two new rungs into the ladder diagram. 
5. Insert an XIC and an OTE in rung 0000. 
6. Insert and XIC and a TON in run 0001. 
7. For the XIC in rung 0000, type in the improper address "I:O/0" (use a capital “o” 

instead of zero). Listen carefully when you hit enter. The computer should play 
an alarm sound when you hit enter. This typically is what happens when 
RSLogix catches an error as you are programming. Do not correct the error yet. 

8. For the OTE in the same rung, type the improper address "O:1/0". You should 
hear the alarm again when you hit enter. 

9. For the XIC in rung 0001, type in the incorrect address "I:1/0". Assign the timer 
the address T4:0 and time base 1.0; do not enter a preset or accum value. 

10. Click on the Verify File icon to view the errors in the ladder. A window with 
four errors listed should appear at the bottom of the screen. The error window 
should look like this (hot word in Directions window). 

11. Before fixing the errors, try to download the program to the processor. 
12. Your request to download the program should have been denied since there were 

errors that were not fixed. 
13. Now you know what type of errors might occur during programming and how 

you can detect the errors. As discussed in the reference, you will become familiar 
with the more common errors that are made during programming. 

14. Fix the errors by clicking on each listed error and making the necessary 
corrections. Try to fix the ladder so that the verify process finds no errors. If you 
need a quick hint, click Here (hot word in Directions window). 

 

Click the Return button. Continue to the next page to resume the activity. 
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Directions Window #2-2 

1. If it isn’t already open, open RSLinx by double-clicking the RSLinx icon on the 
desktop. (You may need to drag the windows on the screen to find the icon.) 

2. Click on the Minimize button in the RSLinx window. 
3. Change the serial switcher to port B, which is not the correct port for the PLC. 
4. Open any one of the program files you have created to this point. 
5. Try to download the program to the processor. 
6. Notice the error message that you receive, and remember the conditions that led 

to the error message. 
7. Change the serial switcher to port A and turn the power to the PLC off. 
8. Make another attempt to download the program to the processor.  
9. You should get the same error message that you got in the previous attempt to 

download. Now you see the importance of familiarity with common errors, often 
two dissimilar problems may give you the same error message or malfunction. It 
is up to you to find the problem with the setup, based on what you have 
experienced. 

10. Turn on the power switch to the processor. 
11. Click on the Controller Properties menu item in the Project Tree window. 
12. Select the incorrect processor 1747-L40A. 
13. Try to download the program to the processor.  
14. Take notice of the error message that appears. 
15. In the same field where you would download a program, select Offline.  
16. In the Controller Properties window, change the processor back to 1747-L20C/F. 
 
Click the Return button. Continue to the next page to resume the activity. 

Directions Window #2-3 

1. If RSLinx is not open, open it by double-clicking the RSLinx icon on the 
desktop. (You may need to drag the windows on the screen to find the icon.) 

2. Click on the Minimize button in the RSLinx window. 
3. In RSLogix, open the file Docum2<your name>. 
4. Read the documentation that you inserted into the program in the last activity. 

You will need to set up the system so that you can run the program as you 
normally would. Try to set up everything without looking back in the lesson, but 
if you need help, refer to Activity 1 of this topic. 

5. When you have set up the system properly, run the program and make sure that 
five blocks are counted and the conveyor is reversed to repeat the process. 

6. Stop the process by turning the PLC off then on again. 
7. Remove the fiber optic sensor cable from the sensor interface box input 0. 
8. In RSLogix, select Remote Run. 
9. The five blocks should continue down the conveyor, past the fiber optic sensor. 

This is because the sensor is not detecting the objects. You should notice that the 
I:0/0 instruction does not energize in the ladder diagram when it is supposed too. 
This would be a very simple malfunction for you to find. 
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10. Turn the PLC off and set up the system again. 
11. Remove the wire from the yellow jack of the conveyor control panel Direction. 
12. Set the processor to the Remote Run mode.  
13. When the program is executed by the PLC, you should notice that the system 

exhibits identical malfunction symptoms as when the input was disconnected. 
The five blocks go past the fiber optic sensor, which does sense them if you look 
at the ladder, but the conveyor does not reverse when it is supposed to. If you 
look at the ladder diagram, the output to reverse the direction is energized, yet 
the conveyor keeps moving forward. This identifies the problem as a bad output 
connection or device.  

14. Although this error may have been picked up during the quick fix, it is 
important to learn the proper steps to take to isolate an output error. You may 
have interpreted this as an input error if you did not look at the ladder diagram 
since the same symptom was seen when the input was purposely disconnected. 

15. Next, have one of your group members, or the instructor, disconnect an input or 
output, or change an address of an input in the ladder diagram. See if you can 
find the problem that is purposely inserted. If any changes are made to the 
ladder diagram, do not save them. 

 
Click the Return button. Continue to the next page to resume the activity. 
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TOPIC 6 – AUTOMATED MANUFACTURING PROJECT 

Objective 

When you have completed this topic, you will be able to design, integrate, program 
and test an operational flexible manufacturing system (FMS).  To complete the topic 
project, you will design and develop a flow chart, input/output map, wiring diagram 
and various software programs.  You will also be required to troubleshoot the FMS 
for connection and program errors.   
 

Overview 

This topic calls upon all the skills you have learned over the course of this CELL.  
You have learned how to program the 5100 and 5200 robots, you also have learned 
how to integrate them with various other components.  You have integrated 
components with the PLC and created and tested PLC programs.  
 
 In this topic you will be given an assignment that will require you to integrate the 
5100, 5200, PLC training system, gravity feeder, pneumatic feeder and conveyor to 
create a FMS.   

New Terms and Words 

None 

Equipment Required 

Armdroid 5100 
Armdroid 5200 
Gravity Feeder 
Pneumatic Feeder 
Rotary Carousel 
Connecting Wires 
PLC and Sensor Trainer 
Conveyor 
Delrin Block 2 X 2 X 1½  (3) 
Delrin Rods 
Student Guide  
RSLogix 500 
RSLinx Lite 
Level 4 Robotic Software 
5100 File Server Software 
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Activity 1 – The Integrated Work Cell 

Objective 

When you have completed this activity, you will have the knowledge and skills to 
integrate the PLC with the Armdroid 5100. 
 
You will be able to: 

• develop a plan to integrate the PLC with the 5100 robot. 
• make the correct wiring connections between the 5V and 24V equipment. 
• program the 5100 to accept inputs from, and send outputs to, the PLC. 
• program the PLC to initiate tasks and accept inputs from the 5100. 

 
 

Direction Windows  #1-1 

 
1.  Set the serial switcher to B so that the computer can communicate with the 

5100.  
 
2.  The first window that opens verifies that the file directory is Data and the 

communications port is COM1. Click OK. 
 
3. Double click on the green icon in the system tray (lower right) on the Windows 

task bar. A small window should appear. There are three fields in the window. 
This window should be visible whenever attempting to load or save a file. If a 
screen saver appears when you try to save or load, you will not be able to see the 
files on the teach pendant. 

 
4. Press any key to get to the Main Menu. 
 
5. Select 5 File I/O. The Armdroid immediately looks for the server. 
 
6. Next, select 2 Save from the menu. Since you are saving a new file, press 1, 

New File.  
 
7.  A window will open on the screen of the PC, in front of the 5100 Server window 

that is normally visible. Type in the name of the file here, Top6act1. Use your 
initials or the first 3 letters of your name in the file name, such as 
“Top6act1Dav” or something similar. When you have typed the name, hit 
Enter. 

 
8. The teach pendant command line will change from Save to Send and then back 

to Save when it is finished. 
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9. The program is now saved on the hard drive of the PC. It can be loaded into the 

Armdroid memory at anytime. 
 
10. Click the Return button. Continue to the next page to resume the activity. 
 

Direction Window #1-2 

 
1.  Open RSLinx by double-clicking the RSLinx.exe icon on the desktop. (You 

may need to drag the windows on the screen to find the icon.) 
 
2. Click on the minimize button in the RSLinx window. 

 
3. In the RSLogix 500 Starter window, open a new file. 

 
4. Click on each rung number to program the rungs one at a time. You should 

include all documentation as well.  
 
Rung 0000 

 
Rung 0001 
 

 
 

5. Verify and save the program as top6task1<your name>. 
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6. When you finish programming the ladder, download the program to the PLC, 
but DO NOT run it.  

 

Direction Window #1-3 

 
1. Turn-on the 24 Vdc power supply, the PLC and conveyor. 
 
2. Go online to the processor by selecting Go Online from the drop down menu 

under the File menu. 
 
3. The system will be online and the PLC will be running your program. 
 
4. To start the 5100 program, press main menu. 
 
5. Press key 2 for Execute. 
 
6. The 5100 will be in standby mode. 
 
7. To start the task, place a block into the gravity feeder. 
 
8. The robot program should start to pick up the block from the gravity feeder.  
 
9. It will place the block on the conveyor. 
 
10.  When the robot has finished, it will send a signal to the PLC. 
 
11.  The PLC will then turn on the conveyor. 
 
12.  The block will move down the conveyor until it passes in front of the diffuse 

sensor. 
 
13.  The PLC will turn the conveyor off when the block is seen by the sensor. 
 
14.  The program is a success. 
 
15.  If there are any problems with the program, use the troubleshooting 

techniques that you learned in a previous topic. 
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Activity 2 – The Final Project 

Objective 

When you have completed this activity, you will have the knowledge and skills to 
design, wire, integrate and program a flexible manufacturing system. 
  
You will be able to: 

• design and develop a flow chart to based on a flexible manufacturing system 
specification. 

• generate an input/output map for the PLC, 5100 and 5200 robot. 
• wire a flexible manufacturing system. 
• program the PLC to work within the system. 
• develop a point program with the 5200 robot. 
• develop and integrate a program using the Level 4 Robotic Software. 
• develop a point program with the 5100 robot.  
• test and troubleshoot a flexible manufacturing system. 
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APPENDIX A – HELP WINDOWS 

Students access the help windows by clicking on the Help button on the screen 
footer. Help can be accessed at any time during the multimedia course. The Help 
menu contains two types of help, labeled topic and system. 

Topic Help Menu 
Topic help contains all the new terms and words that are used for that topic and 
Math help. The menu selections include the following: 
 

♦ New Terms and Words 
♦ Math Help 

 
From the Math selection, a student can access a Math Help menu that has the 
following help windows: 
 

♦ Scientific Notation 
♦ Engineering Notation  
♦ Metric Prefixes 

System Help Menu 

The System Help menu contains an explanation of all the control buttons in the 
screen footer. 
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APPENDIX B – SAFETY 

Working in the Armdroid Robotics System is not very dangerous. However, working 
around any moving equipment has a potential for accidents. As in industrial and 
commercial documentation, a caution alerts the student to possible damage to 
equipment and a warning against personal injury. Students are admonished in the 
following manner in Topic 2 when they first begin operating Armdroid. 
 
 

WARNING: Whenever you work around moving 
equipment, be sure you are not wearing anything that 
might get caught, such as a tie or jewelry. If your hair is 
long, tie it up. 

 

CAUTION: Do not remove or insert any cable connections 
while power is on. Doing so will damage the controller. 

 
 

CAUTION: Do not insert or remove any cable connections 
while the power cable is plugged in. 
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APPENDIX C – INTERNET RESOURCES 

The students should be encouraged to access the following websites on the internet 
to expand their reference base and to explore career opportunities. These sites were 
valid at the time of printing, but are subject to change by their owners at any time. 

 
Automation, Robotics, and Simulation Division 
NASA Johnson Space Center 
Houston, Texas 77058 
 
http://tommy.jsc.nasa.gov/ 
 
Provides information on related organizations, projects, labs, publications, 
education, and research. 
 
 
Robots On Line 
 
http:/www.robotics.org/ 
 
Website of the Robotics Industries Association.  It provides information on 
industry, news, publications, library resources, standards, calendar of events, and 
contacts. 
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APPENDIX E – TROUBLESHOOTING CHARTS 

 
 

System Troubleshooting Chart

START

See Program
Troubleshooting ChartNo

See PLC Communications
Troubleshooting Chart

No

Yes

Did all of the inputs
function properly and
energize in the ladder

diagram when they were
supposed  to?

See Input
Troubleshooting Chart

Yes

No

Did all of the outputs
function properly when  they

were supposed  to?

See Output
Troubleshooting Chart

Yes

No

The program should be working
properly. If not, see your

instructor.

Yes

Were you
able to go online

and download and
monitor the
program?

Were
you able to clear all of the

errors found  in the
program?

Was the output an
Armdroid?

No

Was the input an
Armdroid?

No

See Armdroid
Troubleshooting Chart

Yes

Yes
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START

Did you verify
the program?

Verify the
program.

No

Were errors
found when you

verified the
program?

Yes Yes

Click on each
error listed at bottom of

window, then make necessary
changes to ladder. See chart at
bottom of page for explanation

of error messages.

Were you
able to download
the program to

the PLC?

No

Goto the PLC
Communications
Troubleshooting

Chart.

NoYes

There is no
program error or

communication error.
If the program does

not run properly,
check inputs and

outputs.

Program Troubleshooting Chart
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PLC Communications Troubleshooting
Chart

START
Were errors

found when you
performed the
verification?

Fix all errors in the program
and verify again. Use

Program Troubleshooting
Chart.

Yes

Is 1747-L20C/F
the current processor

selected ?
No

Change the processor type
to 1747-L20C/F in Controller

Properties menu  item in
the Project Tree.

No

Yes

Is the serial cable
connected securely to the

COM1 port, serial switch I/O
port A, and PIC

converter?

Attach serial cable from I/0
port on switcher to the COM1

port on the computer. Attach the
PIC converter to the A port on

the switcher with a 25M to 25M
adapter.  Also, make sure the

PIC converter is securely
attached to the RS-232 port

on  the PLC.

Is there power
to the PLC?

Make sure the switch on
the PLC is on. It should light
up when power is on. Check

power chord if the switch
does not light up.

No

Did you recieve a
 message that states

"Could not gain ownership
of processor."?

Yes

Close RSLogix and
RSLinx, turn PLC off
then on again. Start
RSLogix and RSLinx

and try to download/go
online again. This
should clear the

problem.

Is the
serial switcher
set to port A?

Set the switcher to port A.

Yes

No

Yes

Is RSLinx  running in
the background?

Open RSLinx. It must be
running in the background to

establish communications with
the processor.

No

Is the 1747 PIC/
AIC+ Driver selected

in RSLinx?

Select Configure Drivers
from Communications menu.
The driver should be 1747 PIC /

AIC+ Driver. If it is not listed, click
the down arrow in the Available

Driver Types field, select
1747 PIC / AIC+ Driver,

click Add New.

No

Yes

In the
System Comms

window, from the Comms
menu in RSLogix, do

nodes 00 and 01 show up
 in the window
on the right?

If node 01 UNTITLED
is listed in the window, you

are connected to the
processor. If downloading still

does not work, save the
program, shut down the PLC,

restart the PC, turn on the PLC,
start RSLinx and RSLogix, and

try to download again. If the
node shows up and you
can't download again,

 tell your instructor.

Yes No

No

Yes

No

Communications should be
established at this point.

Have your instructor
troubleshoot the system.

Yes
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Does LED
on sensor
light up?

If input device is an Armdroid, see
Armdroid Troubleshooting Chart

Input Troubleshooting Chart

Does Input
energize

in ladder diagram and
on PLC input

module?

There should be no problem with
the input.

See Output Troubleshooting
Chart

YesNo

Is input device
address in the ladder

the same as the
connection on the

input module? Change input's address in
the ladder diagram so it is the
same as the connection to the

input module or sensor
interface.

No

Is input device
a sensor?

Yes

Was program
properly downloaded
and PLC mode set to

Remote Run?

See PLC
Communications
Troubleshooting

Chart

Yes

No

Are the power
leads connected
from the Power
Supply to the

PLC?

Yes

Connect the leads.
Make sure PLC and
24V power supply

switches are turned on
and power supply is

plugged in. Go to
START.

No

NoYes

Is
sensor cable

firmly connected
to sensor
interface

 box?

Make sure the sensor connector is firmly
seated. This should have been checked during
the quick fix. Go to START. If you end up here

a second time, there may be a malfunction
with the equipment. Consult your instructor.

No

No

The program should work.
Make sure that there are no
forces on the address.  Also
make sure that you are in the

Remote Run mode. If sensor is
not picking up a part, re-
position it so that it points

slightly upward. You also may
be using an inductive sensor

that is designed to pick up only
metal objects. Try again at

START. If you end up here a
second time, there may be a

malfunction with the
equipment. Consult your

instructor.

Yes Yes

START
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Output Troubleshooting Chart

Does Output
energize in ladder
diagram and on
output module?

Was program
properly downloaded
and PLC mode set to

Remote Run?

Yes

See
Communication
Troubleshooting

Chart

No

Are the power
leads connected
from the Power
Supply to the

PLC?

Yes

Connect the leads.
Make sure PLC and
24V power supply

switches are turned
on and power supply
is plugged in. Go to

START.

No

See Program
Troubleshooting

Chart
No

Is the
output device

address in the ladder
the same as the
connection to the

PLC?

Yes

Change output's address in
the ladder diagram so it is the
same as the connection to the

output module.

No

Is the output
device an
Armdroid?

Yes

If output device is an Armdroid, see
Armdroid Troubleshooting Chart

Yes

No

START

Make sure the switch on  the
conveyor control panel is set  to

Remote. The Stop on Signal switch
should always be set to Low.

Make sure ground wire is firmly
connected to both the power

source and the conveyor control
panel. Double check connections

that were checked
 in the quick fix.
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